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This document describes the R&S®SMATE200A, stock no. 1400.7005.02 and its options.

The firmware of the instrument makes use of several valuable open source software packages. The most important of them together
with their corresponding open source license and the verbatim license texts are provided on the user documentation CD-ROM (included
in delivery).
The OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/) includes cryptographic software written by Eric Young
(eay@cryptsoft.com) and software written by Tim Hudson (tjh@cryptsoft.com).
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.
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Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
E-mail: info@rohde-schwarz.com
Internet: http://www.rohde-schwarz.com
Printed in Germany – Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®SMATE200A is abbreviated as R&S SMATE.

http://www.openssl.org/
mailto:info@rohde-schwarz.com
http://www.rohde-schwarz.com


1171.0000.42-05.00 Page 1 

Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any intention other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and a basic knowledge of English. It is therefore essential that only 
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the 
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at 
the appropriate place in the product documentation. Keep the basic safety instructions and the product 
documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories.  

Symbols and safety labels 

Notice, general 
danger location 

Observe product 
documentation 

Caution 
when 
handling 
heavy 
equipment 

Danger of 
electric 
shock 

Warning! 
Hot surface 

PE terminal Ground Ground 
terminal 

Be careful when 
handling 
electrostatic 
sensitive 
devices 

ON/OFF supply 
voltage  

Standby 
indication  

Direct current 
(DC) 

Alternating current 
(AC) 

Direct/alternating 
current (DC/AC) 

Device fully protected by 
double (reinforced) insulation 
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Tags and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These tags are in accordance with the standard definition for civil applications in the European Economic 
Area. Definitions that deviate from the standard definition may also exist in other economic areas or 
military applications. It is therefore essential to make sure that the tags described here are always used 
only in connection with the related product documentation and the related product. The use of tags in 
connection with unrelated products or documentation can result in misinterpretation and in personal injury 
or material damage. 

Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution 
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level, 
max. transport altitude 4500 m above sea level. A tolerance of ±10 % shall apply to the nominal 
voltage and ±5 % to the nominal frequency. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
death. 
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Electrical safety 

If the information on electrical safety is not observed either at all to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with an earthing contact and protective earth connection. 

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is 
not permitted. Doing so can result in the danger of an electric shock from the product. If extension 
cords or connector strips are implemented, they must be checked on a regular basis to ensure that 
they are safe to use. 

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of 
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the 
power plug is easily reachable and accessible at all times (corresponding to the length of connecting 
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from 
the AC supply network. If products without power switches are integrated into racks or systems, a 
disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to 
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully 
laying the power cable, you can ensure that the cable will not be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse 
only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to 
avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the PE terminal on site and the 
product's PE conductor must be made first before any other connection is made. The product may be 
installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as 
well as the product itself, is adequately protected from injury or damage. 
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14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1. Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 

2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal", item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no 
other settings or functions may be used as described in the product documentation. The objective is to 
prevent personal injury (e.g. due to laser beams). 
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Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation 
resistance measurement, leakage current measurement, functional test). This helps ensure the 
continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek 
medical aid immediately. 

5. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

6. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

7. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

8. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  
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2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal 

1. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

Informaciones elementales de seguridad 
Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. 

Símbolos y definiciones de seguridad 

Aviso: punto de 
peligro general 

Observar la 
documentación 
del producto 

Atención en 
el manejo de 
dispositivos 
de peso 
elevado 

Peligro de 
choque 
eléctrico 

Adver-
tencia: 
superficie 
caliente 

Conexión a 
conductor de 
protección 

Conexión 
a tierra 

Conexión 
a masa 

Aviso: Cuidado 
en el manejo de 
dispositivos 
sensibles a la 
electrostática 
(ESD) 

Tensión de 
alimentación de 
PUESTA EN 
MARCHA / 
PARADA  

Indicación de 
estado de 
espera  
(Standby)  

Corriente 
continua (DC) 

Corriente alterna 
(AC) 

Corriente 
continua / 
Corriente alterna 
(DC/AC) 

El aparato está protegido 
en su totalidad por un 
aislamiento doble 
(reforzado) 
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Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  

1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, grado de suciedad 2, categoría de sobrecarga eléctrica 2, uso 
solamente en estancias interiores, utilización hasta 2000 m sobre el nivel del mar, transporte hasta 
4500 m sobre el nivel del mar. Se aplicará una tolerancia de ±10 % sobre el voltaje nominal y de 
±5 % sobre la frecuencia nominal. 

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, pueden 
causarse lesiones o incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 
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Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, se deberá considerar 
el enchufe del cable de conexión como interruptor. En estos casos se deberá asegurar que el enchufe 
siempre sea de fácil acceso (de acuerdo con la longitud del cable de conexión, aproximadamente 
2 m). Los interruptores de función o electrónicos no son aptos para el corte de la red eléctrica. Si los 
productos sin interruptor están integrados en bastidores o instalaciones, se deberá colocar el 
interruptor en el nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  

6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 
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12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 

Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos 
(p. ej. el níquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones 
alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la conjuntiva o 
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y 
evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación", punto 1. 
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5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Mantener baterías y celdas fuera del alcance de los niños. En caso de ingestión de una celda o 
batería, avisar inmediatamente a un médico. 

5. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 
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6. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

7. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

8. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación 

1. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

2. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 
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Kundeninformation zum Batteriegesetz (BattG) 

Dieses Gerät enthält eine Batterie bzw. Akkumulator. Die-
se dürfen nicht mit dem Hausmüll entsorgt werden. 

Nach Ende der Lebensdauer darf die Entsorgung nur über 
eine geeignete Sammelstelle oder eine Rohde & Schwarz-
Kundendienststelle erfolgen. 

Beachten Sie unbedingt die Hinweise zu Batterien und 
Akkumulatoren in den grundlegenden Sicherheitshinwei-
sen. 

Safety Regulations for Batteries (according to BattG) 

This equipment houses a battery or rechargeable battery that may not be disposed of as 
normal household waste. 

After its useful life, the battery or rechargeable battery may only be disposed of at a 
suitable depot or at a Rohde & Schwarz customer service center.  

Always follow the instructions on batteries and rechargeable batteries in the basic safety 
instructions. 

Información para el cliente relativa a la Ley de Baterías (BattG) 

Este equipo contiene una batería o acumulador, que no se deben desechar en los con-
tenedores de basura domésticos. 

Después de la vida útil, la batería solo se podrá eliminar en un depósito apropiado o en 
un centro de atención al cliente de Rohde & Schwarz.  

Le rogamos que respete escrupulosamente las indicaciones referidas a baterías, acu-
muladores contenidas en las instrucciones de seguridad elementales. 

Consignes de sécurité pour batteries (selon la loi BattG) 

Cet appareil contient des batteries (piles, batteries et accumulateurs) qui ne doivent pas 
être jetées dans une poubelle pour ordures ménagères. 

Une fois usagées, elles doivent être éliminées dans un centre de collecte agréé ou un 
centre de service clients de Rohde & Schwarz. 

Veillez à respecter scrupuleusement les consignes de sécurité fondamentales concer-
nant les piles, batteries et accumulateurs. 



1171.0200.52-01.01 

Customer Information Regarding Product Disposal 
 

The German Electrical and Electronic Equipment (ElektroG) Act is an implementation of 
the following EC directives: 

• 2002/96/EC on waste electrical and electronic equipment (WEEE) and 
• 2002/95/EC on the restriction of the use of certain hazardous substances in 

electrical and electronic equipment (RoHS). 

Product labeling in accordance with EN 50419 

Once the lifetime of a product has ended, this product must not be disposed of 
in the standard domestic refuse. Even disposal via the municipal collection 
points for waste electrical and electronic equipment is not permitted. 

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept for the 
environmental-friendly disposal or recycling of waste material and fully assumes its 
obligation as a producer to take back and dispose of electrical and electronic waste 
in accordance with the ElektroG Act. 

Please contact your local service representative to dispose of the product. 
 



Sehr geehrter Kunde,
Sie haben sich für den Kauf eines  
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein 
nach modernsten Fertigungsmethoden 
hergestelltes Produkt. Es wurde nach 
den Regeln unseres Qualitätsmanage-
mentsystems entwickelt, gefertigt  
und geprüft. Das Rohde & Schwarz-
Qualitätsmanagementsystem ist u.a.  
nach ISO 9001 und ISO 14001  
zertifiziert. 

Der Umwelt verpflichtet
Energie-effiziente,  JJ

RoHS-konforme Produkte
Kontinuierliche Weiterentwicklung JJ

nachhaltiger Umweltkonzepte
ISO 14001-zertifiziertes  JJ

Umweltmanagementsystem 

Dear Customer,
You have decided to buy a  
Rohde & Schwarz product. You are 
thus assured of receiving a product 
that is manufactured using the most 
modern methods available. This 
product was developed, manufactured 
and tested in compliance with our 
quality management system stan-
dards. The Rohde & Schwarz quality 
management system is certified 
according to standards such as 
ISO 9001 and ISO 14001. 

Environmental commitment
Energy-efficient productsJJ

Continuous improvement in  JJ

environmental sustainability
ISO 14001-certified environmental JJ

management system

Cher client,
Vous avez choisi d’acheter un pro-
duit Rohde & Schwarz. Vous disposez 
donc d’un produit fabriqué d’après les 
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests 
respectent nos normes de gestion 
qualité. Le système de gestion qualité 
de Rohde & Schwarz a été homologué, 
entre autres, conformément aux nor-
mes ISO 9001 et ISO 14001. 

Engagement écologique
Produits à efficience énergétiqueJJ

Amélioration continue de la durabilité JJ

environnementale
Système de gestion de l’environne-JJ

ment certifié selon ISO 14001

Certified Environmental System

ISO 14001

Certified Quality System

ISO 9001
Qualitätszertifikat
Certificate of quality
Certificat de qualité

11
71

.0
20

0.
11

 V
 0

4
.0

1



1171.0200.22-06.00 

Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface

1.1 Documentation Overview

The user documentation for the R&S SMATE consists of the following parts:

● Online Help system on the instrument,
● "Quick Start Guide" printed manual,
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help,
– Operating Manuals for base unit and options,
– Service Manual,
– Data sheet and specifications,
– Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SMATE and all available options.

Quick Start Guide

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start working
with the instrument. Basic operations and an example of setup are described. The manual
includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error mes-
sages is also given.

In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S SMATE is not included in the
option manuals.

The following Operating Manuals are available for the R&S SMATE:
● Digital Standard GSM/EDGE, incl. EDGE+
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● Digital Standard 3GPP FDD, 3GPP FDD enhanced MS/BS tests incl. HSDPA, 3GPP
FDD HSUPA, 3GPP FDD HSPA+

● Digital Standard GPS and Assisted GPS
● Digital Standard CDMA2000® incl. 1xEV-DV
● Digital Standard 1xEV-DO Rev. A
● Digital Standard IEEE 802.11 (a/b/c) WLAN
● Digital Standard IEEE 802.16 WiMAX
● Digital Standard TD-SCDMA, inclusive TD-SCDMA enhanced features
● Digital Standard DVB-H
● Digital Standard DAB / T-DMB
● Digital Standard IEEE 802.11n WLAN-N
● Digital Standard EUTRA/LTE
● Digital Standard XM Radio
● FM Stereo / RDS
● Digital Standard Sirius Radio
● Digital Standard TETRA Release 2
● Digital Standard Bluetooth®Enhanced Data Rate

These manuals can also be orderd in printed form (see ordering information in the data
sheet).

Service Manual

This Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. It describes how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).

Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

1.2 Typographical Conventions

The following text markers are used throughout this documentation:
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Convention Description

"Graphical user interface elements" All names of graphical user interface elements on the
screen, such as dialog boxes, menus, options, but-
tons, and softkeys are enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands, program code File names, commands, coding samples and screen
output are distinguished by their font.

Input Input to be entered by the user is displayed in italics.

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are
enclosed by quotation marks.

Typographical Conventions





Preparing for UseR&S®SMATE200A

13Quick Start Guide 1401.0933.69 ─ 07

2 Preparing for Use
The following topics will help you to get familiar with the instrument and perform the first
steps:
● ​Front Panel Tour
● ​Rear Panel Tour
● ​Putting into Operation

This section explains the control elements and connectors of the Signal Generator R&S
SMATE with the aid of the front and rear views and describes how to put the instrument
into operation. It also describes the connection of peripherals such as printer, keyboard
or mouse. Specifications of interfaces can be found in the data sheet.

Manual and remote control of the instrument
● The R&S SMATE is primarily intended to be remote-controlled via the GPIB interface

or a LAN connection (see ​chapter 5, "Remote Control Basics", on page 109).
Alternatively it is possible to control the instrument manually using an external monitor
in combination with a keyboard and a mouse (see also ​chapter 2.4, "Connecting
External Accessories", on page 26) or by accessing the instrument via the remote
control desktop of an external PC (see also ​chapter 2.7, "Remote Access via an
External Controller", on page 34).

● Several hardware control lines are provided for direct and fast access to instrument
functions, e.g. to RF OFF and MOD OFF switching (​chapter 4.1, "Legend of Manual
Controls", on page 71).

● Manual and remote control of the R&S SMATE are described in separate chapters.
Background information about the settings and about the digital standards is reported
in the reference chapter for manual control (see chapter "Instrument Functions" in
the Operating Manual), together with the dialogs that may be displayed on an external
monitor. To avoid redundancy, the reference chapter for remote control (chapter
"Remote Control Commands" in the Operating Manual) focusses on program syntax
and parameter ranges but contains only a short description of the command func-
tions.

The ​chapter 3, "Getting Started", on page 53 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating instruc-
tions and an overview of menus follow in ​chapter 4, "Manual Operation", on page 71.

For all reference information concerning manual and remote control of the instrument
refer to the online help system or its printed/printable version. A more detailed description
of the hardware connectors and interfaces is also part of the help system.

2.1 Front Panel Tour

This section gives an overview of control elements on the front panel of the R&S Signal
Generator. The connectors of the R&S Signal Generator are placed on the rear panel
and are described in ​chapter 2.2, "Rear Panel Tour", on page 15.
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As the R&S Signal Generator is mainly intended to be remote-controlled, the front panel
of the R&S Signal Generator contains no display but mostly LEDs to inform the user about
the status of the instrument. The user interface can be displayed on an external monitor
that is either connected directly to the instrument or that belongs to a remote PC station
used to manually remote control the instrument.

For more detailed information, refer to the corresponding description in the Operating
Manual.

Fig. 2-1: Front panel view

2.1.1 Status LEDs for intrument state

The Status LEDs for intrument state are located in the left corner of the front panel.

ERROR
Indicates that an error occurred during operation. Only errors are indicated that impair
further instrument operation, e.g. a hardware fault. The error must be eliminated before
correct instrument operation can be ensured.

Errors are queried with commands SYST:ERR:ALL?, SYST:ERR[:NEXT]? and
SYST:SERR?.

REMOTE
Indicates that the instrument is in remote control mode.

If using an external monitor and an external keyboard, the external display remains
unchanged and shows the current instrument status, i.e. the status which exists under
the remote control settings. The instrument can be operated (e.g. dialogs can be opened).
However, it is not possible to enter or change values.
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BUSY
Indicates that the instrument is booting the operating system and firmware software.

READY
Indicates that the instrument is ready for operation after booting the instrument.

2.1.2 Standby LEDs and Standby Key

The standby LEDs and the ON/STANDBY key are located in the bottom left corner of the
front panel.

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
● the green LED (left) is on when the instrument is ready for operation,
● the yellow LED (right) is on in the standby mode.

See also ​chapter 2.3.4.1, "Standby and Ready state", on page 23.

2.1.3 Status LEDs for RF outputs

The green LEDs indicate that the RF output A/B on the rear of the instrument is switched
on.

2.1.4 Status LED for LXI

The LED indicates the LXI states as follow:
● the red LED is on by LAN fault or no LAN connection
● the green LED indicates that LAN is active (normal operation)
● the green LED flasches by device indentification.

2.1.5 LAN Reset

The LAN Reset initiates the network configuration reset mechanism for the instrument
and resets the network settings of the instrument when pressed for longer than 4 sec.

For more information, refer to section "LXI Status" in the Operating Manual.

2.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing detailed
information. For technical data of the connectors refer to the data sheet.
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If a connector of a two-path instrument is available for one path only (e.g. path A) or for
either of the two (path A or B), a note is made in the brief description.

For more detailed information, refer to the corresponding description in the Operating
Manual.

Fig. 2-2: Rear panel view

2.2.1 Description of the Connectors

RF A, RF B
Outputs for RF signal of path A and path B.

NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum permis-
sible back-feed is specified in the data sheet.

LAN CONNECTOR
Ethernet interface
● For integrating signal generators in a network
● Remote control of signal generator
● Input of external asynchronous data
● Remote access to the signal generator
● Firmware update
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See also:
● ​chapter 2.6, "Setting Up a Network (LAN) Connection", on page 30
● chapter "Remote Control Basics" in the Operating Manual

VENTILATION SLOTS
NOTICE! Risk of damage through overheating!. Ventilation slots must not be obstructed.
Make sure that the air can escape freely through the vents at the rear. The minimum
distance to the wall should be at least 10 cm.

AC SUPPLY AND POWER SWITCH
When the R&S SMATE is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set the
voltage manually or change fuses.

The instrument comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.

The power switch can be set to two positions:
● 0

The instrument is disconnected from the mains.
● I

The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the instru-
ment front.

See also data sheet and ​chapter 2.3.3, "Connecting the Instrument to the AC Sup-
ply", on page 22.

REF OUT
Output of internal reference signal.

REF IN
Input for external reference signal.

The external reference is used for both paths.

CLOCK IN/OUT
Clock signal input/output.

CLOCK IN Input for external clock signal (bit or symbol clock, multiple of symbol
clock) for synchronizing the external data signal in case of multivalent
modulation. The active edge can be set (path A only).

CLOCK OUT Output for internal (bit or symbol) clock signal (path A). The internal
clock signal of path B can be output at one of the USER interfaces.

LF
(path A only)

Output for internal LF modulation generator signal.

See also data sheet and Operating Manual, section "LF Generator and LF Output".

Rear Panel Tour
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I OUT BAR / Q OUT BAR
(path A or path B)

Differential (inverting) output for analog I/Q signal.

I OUT / Q OUT
(path A or path B)

Direct output or Differential (non-inverting) output for analog I/Q signal.

Option option R&S SMATE-B16 is required.

I IN A/B, Q IN A/B
Input for external analog modulation signal in case of I/Q modulation (independent for
path A and B).

For more information see chapter "Data and Signal Sources in Baseband" and "I/Q Set-
tings" in the Operating Manaul.

EXT MOD
Input for external analog modulation signals.

The instrument is equipped with two separate inputs for path A and path B.

LO IN, LO OUT
Local oscillator input and output:
● LO IN: Input for external LO signals
● LO OUT: Output for internal LO signals.

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also ​chapter A.1, "GPIB Bus Interface", on page 155 and chapter "Remote Control
Basics" in the Operating Manual.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines, always
terminate any connected IEC-bus cable with an instrument or a controller.

USB IN
USB (universal serial bus) interface of type B (device USB).

This interface can be used for remote control of the instrument.

Input for external asynchronous modulation data (path A only). The interface establishes
a connection to the DACIF module.

If required, separate drivers can be developed for this interface. The device ID required
in this case is 11 (HEX) for remote control and 12 (HEX) for the transmission of modulation
data. The vendor ID is AAD (HEX).

USB CONNECTORS TYPE A
● Connection of peripherals such as mouse, keyboard, etc.
● Connection of memory stick for file transmission
● Firmware update
The interface establishes a connection to the controller.

See also ​chapter 2.4.1, "Connecting USB Devices", on page 26.

Rear Panel Tour
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MONITOR
Connector for external monitor (see ​chapter 2.4.2, "Connecting a Moni-
tor", on page 28).

For description of this connector, refer to ​chapter A.3, "Monitor Connector (MONI-
TOR)", on page 158.

AUX I/O

Parallel input/output for data signals as well as settable trigger and control signals of the
baseband. Input for device trigger.

Assignment of the AUX I/O interface and of USER pins can be configured in the "Setup
> Global Trigger/Clock/External Inputs" and "Setup > USER Marker / AUX I/O Settings".

Use this dialogs to configure also the arbitrary assignment of pins to path A or B.

Note: An adapter of the AUX I/O interface to coaxial BNC connectors is available as an
accessory (R&S SMATE-Z5, see data sheet).
For detailed description of the AUX I/O connector, refer to ​chapter A.2, "AUX I/O Con-
nector", on page 156.

DIGITAL I/O
Input/output for serial data of digital signals as well as settable trigger and control signals
of the baseband. Input for device trigger for path A.

Assignment of most of the pins of the DIGITAL I/O interface is permanent and cannot be
changed. Some of the pins are assigned the same input/output as pins of the AUX I/O
interface, e.g. CLK OUT. This is provided to enable the use of a single connector for the
input of parallel or serial data.

Assignment of the USER pin can be configured in the SETUP > "Global Trigger/Clock/
External Inputs" and "USER Marker / AUX I/O Settings". The corresponding SCPI com-
mand is :OUTPut:USER.

An adapter of the DIGITAL I/O interface to coaxial BNC connectors is available as an
accessory (R&S SMATE-Z5, see data sheet).

For a description of the connector, see ​chapter A.4, "Digital I/O inter-
face", on page 158.

2.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SMATE for
the first time.
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Shock hazard
Do not open the instrument casing. As a rule, normal operation of the instrument does
not require opening the casing. Observe the general safety instructions and regulations
at the beginning of the manual.

Risk of instrument damage
Note that the general safety instructions also contain information on operating conditions
that will prevent damage to the instrument. The instrument's data sheet may contain
additional operating conditions.

Risk of instrument damage
Before switching on the instrument, make sure that the following conditions are met:
● Instrument casing is closed and all fasteners are tightened.
● All fan openings are unobstructed and the airflow perforations are unimpeded. The

minimum distance from the wall is 10 cm.
● The instrument is dry and shows no sign of condensation.
● The instrument is operated in the horizontal position on an even surface.
● The ambient temperature does not exceed the range specified in the data sheet.
● Signal levels at the input connectors are all within the specified ranges.
● Signal outputs are correctly connected and are not overloaded.

Failure to meet these conditions may cause damage to the instrument or other devices
in the test setup.

Risk of electrostatic discharge
Protect the work area against electrostatic discharge to avoid damage to electronic com-
ponents in the modules. For details, refer to the safety instructions at the beginning of
this manual.

Putting into Operation
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EMI impact on measurement results
Electromagnetic interference (EMI) can affect the measurement results. To avoid any
impact, make sure that the following conditions are met:
● Use suitable double-shielded cables.
● Do not use USB connecting cables exceeding 1 m in length.
● Use only USB devices that remain within the permissible EMI limits.
● Always terminate any connected IEC-bus cables with an instrument or controller.

Outputs and lines have to be terminated properly with 50 Ohms.
For digital interfaces only the cable R&S SMATE-Z6 is permitted for connection. The
associated cable is available under part number 1415.0201.02.

2.3.1 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for completeness
proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.

3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

Packing material
Retain the original packing material. If the instrument needs to be transported or shipped
at a later date, you can use the material to prevent control elements and connectors from
being damaged.

2.3.2 Placing or Mounting the Instrument

The R&S SMATE is designed for use under laboratory conditions, either on a bench top
or in a rack using a rack adapter kit (order number see data sheet).
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Bench Top Operation

If the R&S SMATE is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.

Risk of injury
The feet may fold in if they are not folded out completely or if the instrument is shifted.
Fold the feet completely in or completely out to ensure stability of the instrument and
personal safety. To avoid injuries, never shift the instrument when its feet are folded out.
When the instrument is standing on its folded-out feet, do not work under the instrument
and do not put anything under it, otherwise injuries or material damage could occur.
The feet may break if they are overloaded. The overall load on the folded-out feet must
not exceed 500 N.

Rackmounting

The R&S SMATE can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage
For rack installation, make sure that all fan openings are unobstructed and that the airflow
perforations are unimpeded. This helps to prevent the instrument from overheating.

2.3.3 Connecting the Instrument to the AC Supply

The R&S SMATE is automatically adapted to the AC voltage supplied. There is no need
to set the voltage manually or change fuses. The ​AC SUPPLY AND POWER SWITCH
is at the rear of the unit.

► Connect the instrument to the AC power source using the AC power cable delivered
with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

2.3.4 Starting the Instrument

The R&S SMATE comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.
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Switching off the AC power
You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from all
power supplies.

Starting up instruments with power switch

1. ​Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position I (On).

After power-up, the instrument is in ​standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

Starting up instruments without power switch

1. ​Connect the instrument to the AC supply.

After connection to the AC supply, the instrument is in ​standby or ready state,
depending on the state of the ON/STANDBY key at the front panel of the instrument
when the instrument was switched off for the last time.

2. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

2.3.4.1 Standby and Ready state

The ON/STANDBY key is located in the bottom left corner of the front panel.

Switching between standby and ready state

► Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S SMATE initiates its ​startup procedure.
In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

2.3.4.2 Start Display and Booting

After power-on, the start display indicates for a few seconds the installed BIOS version
and the processor characteristics.

 

 

Putting into Operation



Preparing for UseR&S®SMATE200A

24Quick Start Guide 1401.0933.69 ─ 07

The instrument boots the operating system, starts the instrument firmware and automat-
ically performs a selftest. If the previous session was terminated regularly, the instrument
uses the last setup with the relevant instrument settings.

Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the cur-
rent setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument
Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

2.3.4.3 Function Check

The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.

A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO key.
In response, a description of the error(s) is displayed.

For more information, refer to section "Error Messages" in the Operating Manual.

Additionaly to the automatic monitoring, the R&S SMATE offers the following capabilities
to ensure correct functioning:
● Internal Adjustments

Press the SETUP key and select "System > Internal Adjustments" to access the dia-
log for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

● Selftest
A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled.

2.3.4.4 Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched off. It is also recomen-
ded that you use the PRESET key to return the instrument to its defined preset state
every time a new configuration is required or the current setup is not anymore relevant.

The R&S SMATE offers a three-stage preset concept:
● Preset of the settings belonging to a digital standard or associated with one dialog.

Most of the dialog boxes provide a special "Set to Default" button that resets directly
the settings associated to the corresponding dialog, e.g. all digital modulation settings
in the "Custom Digital Mod" dialog.
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These settings are identical to those which are called up using the PRESET key.
● Preset the instrument to a predefined state

The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument
settings provide a reproducible initial basis for all other settings. However, functions
that concern the integration of the instrument into a measurement setup are not
changed, e.g. GPIB bus address or reference oscillator source settings.
In remote control it is possible to preset the settings of the two instrument's paths
separately (see section "Preset Commands").

● Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see section "Factory Preset" in the Operating Manual.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.
● "RF frequency" = 1 GHz
● "RF level" RF output switched off
● "Offsets" = 0
● "Modulations State" = Off
● Uninterrupted level settings are switched off

"Level Attenuator Mode" = AUTO
● Internal level control "Level ALC" = AUTO
● User correction "Level Ucor" = OFF
● "LF output State" = Off
● "Sweep State" = Off
● "List mode State" = Off

Settings that are not affected by the PRESET key

● Reference frequency settings ("Ref Oscillator" menu)
● Power on settings ("Level/EMF" menu)
● Network settings ("Setup" menu)
● GPIB address ("Setup" menu)
● Password and settings protected by passwords ("Setup" menu)
● Start/Stop Gui Update ("Setup" menu)
● Display and keyboard settings ("Setup" menu)

User-defined instrument states can be stored and called up in the "File" dialog.
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2.3.5 Shutting Down the Instrument

To shut down the R&S SMATE, proceed as described below.

Risk of losing data
If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data may
be lost.
Press the ON/STANDBY key first to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.

2. To turn the power off:

a) For instruments with power switch, press the main power switch to position 0
(Off).

b) For instruments without power switch, pull the power cable at the rear of the
instrument.

Tip:
Switching off the AC power
You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from
all power supplies.

None of the front-panel LEDs should be on.

2.4 Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S SMATE can be used
to connect a variety of accessories.

In addition the instrument provides interfaces for monitor connection and network inte-
gration (see ​chapter 2.4.2, "Connecting a Monitor", on page 28 and ​chapter 2.6.1,
"Connecting the Instrument to the Network", on page 31).

2.4.1 Connecting USB Devices

The USB interfaces on the front and (optionally) rear panels of the R&S SMATE allow
you to connect USB devices directly to the instrument. This number can be increased as
necessary by using USB hubs. Due to the large number of available USB devices, there
is almost no limit to the expansions that are possible with the R&S SMATE.
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The following list shows various USB devices that can be useful:
● Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)
● CD-ROM drives for easy installation of firmware applications
● Keyboard or mouse to simplify the entry of data, comments, file names, etc.
● Printer for printing out measurement results
● Power sensors, e.g. of the NRP Zxy family

Installing USB devices is easy under Windows XP, because all USB devices are
plug&play. After a device is connected to the USB interface, Windows XP automatically
searches for a suitable device driver.

If Windows XP does not find a suitable driver, it will prompt you to specify a directory that
contains the driver software. If the driver software is on a CD, connect a USB CD-ROM
drive to the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S SMATE, Windows XP
immediately detects the change in hardware configuration and deactivates the corre-
sponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.

Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, Windows XP informs you
that the device is ready to use. The device is made available as a new drive ("D:") and
is displayed under Windows Explorer. The name of the drive is manufacturer-dependent.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default input language
is English – US.

Use the "Start > Control Panel > Keyboard" or the "Regional and Language Options"
menu of Windows XP to configure the keyboard properties. To access Windows XP,
press the Windows key on the external keyboard.

Connecting a mouse

The mouse is detected automatically when it is connected.

Use the "Start > Control Panel > Mouse" menu of Windows XP to configure the mouse
properties. To access Windows XP, press the Windows key on the external keyboard.

Connecting a printer

When printing a file, the instrument checks whether a printer is connected and turned on
and whether the appropriate printer driver is installed. If required, printer driver installation
is initiated using Windows XP's "Add Printer" wizard. A printer driver needs to be installed
only once.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. If the instrument is inte-
grated in a network, you can also install driver data stored in a network directory. Use the
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"Add Printer" wizard on the "Start > Settings > Printer and Faxes" menu to install the
driver. To access Windows XP, press the Windows key on the external keyboard.

2.4.2 Connecting a Monitor

An external monitor with an analog interface can be connected to the MONITOR con-
nector on the rear panel of the instrument. Per default, the external monitor connector is
disabled and has to be enabled before operation.

Connecting external devices
Before connecting any external device such as a monitor, make sure that the instrument
is switched off (or in standby mode). Otherwise, correct operation cannot be assured.
This does not apply to USB devices.

1. ​Shut down the instrument.

None of the front-panel LEDs should be on.

2. Plug in the monitor cable to the MONITOR connector on the rear panel of the instru-
ment.

3. ​Start up the instrument.

The green LED must be on.

The external monitor is detected.
The entire display of the instrument, containing the status bar, the block diagram and
the winbar is displayed on the monitor additionally. Further settings are not required.

The MONITOR interface is described in "Appendix A: Hardware Interfaces" in the Oper-
ating Manual.

2.5 Windows Operating System

The instrument contains the Windows XP operating system which has been configured
according to the instrument's features and needs. To ensure that the instrument software
functions properly, certain rules must be adhered to concerning the operating system.
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Risk of causing instrument unusability
The instrument is equipped with the Windows XP operating system. Additional software
can therefore be installed on the instrument. The use and installation of additional soft-
ware may impair instrument function. Thus, run only programs that Rohde & Schwarz
has tested for compatibility with the instrument software.
The drivers and programs used on the instrument under Windows XP have been adapted
to the instrument. Existing instrument software must always be modified using only
update software released by Rohde & Schwarz.

The following program packages have been tested:
● R&S Power Viewer - virtual power meter for displaying results of the Power Sensor

R&S NRP-Zxx
● Windows XP Remote Desktop
● Symantec Norton AntiVirus – Virus-protection software

In certain cases, the use of these programs can impair the performance of the instrument.

2.5.1 Virus Protection

Users must take appropriate steps to protect their instruments from infection. Beside the
use of strong firewall settings and regularly scanning any removable storage device used
with a R&S instrument, it is also recommended that anti-virus software be installed on
the instrument. While Rohde & Schwarz does NOT recommend running anti-virus soft-
ware in the background ("on- access" mode) on Windows-based instruments, due to
potentially degrading instrument performance, it does recommend running it during non-
critical hours.

For details and recommendations, see the R&S White Paper "Malware Protection" avail-
able at http://www.rohde-schwarz.com/appnote/1EF73.

2.5.2 Service Packs and Updates

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. These are released through the Microsoft Update website and
associated update server. Instruments using Windows, especially those that connect to
a network, should be updated regularly.

For more details and information on configuring automatic updates see the R&S White
Paper "Malware Protection" (available at http://www.rohde-schwarz.com/appnote/
1EF73).

Changes in the system setup are only required when peripherals like keyboard or a printer
are installed or if the network configuration does not comply with the default settings (see
​chapter 2.6.1, "Connecting the Instrument to the Network", on page 31). After the R&S
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SMATE is started, the operating system boots and the instrument firmware is started
automatically.

2.5.3 Login

Windows XP requires that users identify themselves by entering a user name and pass-
word in a login window. The instrument provides a factory-installed auto login function,
i.e. login is carried out automatically in the background. The ID used for autologin has
administrator rights so that printer and network installations are possible. The user name
and password are set to "instrument".

2.5.4 Accessing the Start Menu

The Windows XP "Start" menu provides access to the Windows XP functionality and
installed programs. To open the "Start" menu, press the Windows key or the CTRL + ESC
key combination on your keyboard.

All necessary system settings can be made in the "Start > Control Panel" menu (for
required settings refer to the Windows XP manual and to the hardware description).

Accessing Operating System
The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

Energy saving mode

An energy saving mode is a default setting in the instrument. The hard disk switches to
power-save mode if it is not accessed for 30 minutes. The energy-saving mode is exited
by accessing the hard disk again.

2.6 Setting Up a Network (LAN) Connection

The R&S SMATE is equipped with a network interface and can be connected to an
Ethernet LAN (local area network). Provided the appropriate rights have been assigned
by the network administrator and the Window XP firewall configuration is adapted accord-
ingly, the interface can be used, for example:

● To transfer data between a controller and the tester, e.g. in order to run a remote
control program. See chapter "Remote Control"

● To access or control the measurement from a remote computer using the "Remote
Desktop" application (or a similar tool)

● To connect external network devices (e.g. printers)
● To transfer data from a remote computer and back, e.g. using network folders
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This section describes how to configure the LAN interface. It includes the following topics:

● ​chapter 2.6.1, "Connecting the Instrument to the Network", on page 31
● ​chapter 2.6.2, "Assigning the IP Address", on page 32

LXI
The R&S SMATE complies with LXI Class C. LXI gives you direct access to the LAN
settings described below.

Accessing Operating System
The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

2.6.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

● A non-dedicated network (Ethernet) connection from the instrument to an existing
network made with an ordinary RJ-45 network cable. The instrument is assigned an
IP address and can coexist with a computer and with other hosts on the same net-
work.

● A dedicated network connection (Point-to-point connection) between the instrument
and a single computer made with a (crossover) RJ-45 network cable. The computer
must be equipped with a network adapter and is directly connected to the instrument.
The use of hubs, switches, or gateways is not required, however, data transfer is still
performed using the TCP/IP protocol. An IP address has to be assigned to the instru-
ment and the computer, see ​chapter 2.6.2, "Assigning the IP
Address", on page 32.
The R&S SMATE uses the IP addresses 192.168.xxx.yyy for this purposes, where
xxx and yyy may take values between 1...254; the subnet mask is always
255.255.255.0.

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult your
network administrator. Errors may affect the entire network.

► To establish a non-dedicated network connection, connect a commercial RJ-45 cable
to one of the LAN ports.
To establish a dedicated connection, connect a (crossover) RJ-45 cable between the
instrument and a single PC.
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If the instrument is connected to the LAN, Windows XP automatically detects the network
connection and activates the required drivers.

The network card can be operated with a 10/100/1000 Mbps Ethernet IEEE 802.3u inter-
face.

2.6.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instrument
can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host Con-

figuration Protocol (DHCP), all address information can be assigned automatically.
● If the network does not support DHCP, or if the instrument is set to use alternate TCP/

IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous instrument configuration.

Risk of network errors
Connection errors can affect the entire network. If your network does not support DHCP,
or if you choose to disable dynamic TCP/IP configuration, you must assign valid address
information before connecting the instrument to the LAN. Contact your network admin-
istrator to obtain a valid IP address.

Assigning the IP address manually

1. Obtain the IP address and subnet mask for the R&S SMATE and the IP address for
the local default gateway from your network administrator. If necessary, also obtain
the name of your DNS domain and the IP addresses of the DNS and WINS servers
on your network. If you use more than one LAN connector, you need separate
address information for each connector.

2. Press the "Windows" key to access the operating system.

3. Open the "Control Panel" by selecting "Start > Settings > Control Panel".

4. Select "Network Connections".

5. Right-click "Local Area Connection" and select "Properties" from the context-sensi-
tive menu, or
click "Local Area Connection" and then "File > Properties".

6. On the "General" tab, click "Internet Protocol (TCP/IP)" and then select "Properties".

7. Select "Use the following IP address" and enter the address information as obtained
from the network administrator.
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8. If necessary, you can also select "Use the following DNS server addresses" and enter
your own DNS addresses.

For more information refer to the Windows XP Help.

2.6.3 Using computer names

Alternatively to the IP address, each PC or instrument connected in a LAN can be
accessed via an unambiguous computer name. Each instrument is delivered with an
assigned computer name, but this name can be changed.

Querying and changing a computer name

1. Press the "Windows" key to access the operating system.

2. Select "Start > My Computer > Properties > Computer Name".

The computer name is displayed under "Full Computer Name".

3. To change the computer name, select "Change", enter the new computer name and
confirm the entry.

2.6.4 Changing the Windows Firewall Settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends the use of the firewall on
your instrument. R&S instruments are shipped with the Windows firewall enabled and
preconfigured in such a way that all ports and connections for remote control are enabled.
For more details on firewall configuration see the R&S White Paper "Malware Protection"
(available at http://www2.rohde-schwarz.com/file_13784/1EF73_0E.pdf) and the Win-
dows XP help system.

Note that changing firewall settings requires administrator rights.

To transfer waveform files generated on an external PC using R&S WinIQSIM2, you have
to disable the firewall.

Risk of Unauthorized Access
Disabling the firewall or allowing exceptions may make your instrument more vulnerable
to viruses and intruders.
It is recommended that you restore the default firewall configuration after completing a
task which requires modified settings.
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2.6.5 Working with Directories

Access to network drives depends on access rights and whether the drives in question
have been enabled. The complete integration of the R&S Signal Generator into a larger
network with the necessary allocation of rights is highly complex and normally performed
by a network administrator.

However, the hard disk of a computer also connected to the network can be accessed
from the instrument relatively easily. The only precondition is that the directory on the
remote computer that the instrument should access is enabled for remote access. Sub-
sequently, this directory is accessed from the instrument using a Windows XP search
function. This procedure is also of importance for a point-to-point connection, for instance
in order to start a firmware update for which the files have been stored on the hard disk
of the remote computer.

The computer and the instrument must both be provided with a computer name and an
IP address (see ​chapter 2.6.2, "Assigning the IP Address", on page 32).

Enabling directories on the remote computer

The menu name may deviate from the name specified in the operating sequence,
depending on the language and on the operating system used on the computer.

1. On the remote computer, in Windows Explorer, click the directory to be enabled.

2. From the context menu, select "Properties".

3. Select the "Sharing" tab and enable "Share this folder".

Accessing the enabled directory

1. On the instrument, select "Start > Search > For Files and Folders > Printers, Com-
puters > A Computer in the Network".

2. Enter the computer name and press ENTER to start the search.

The computer and its name appears in the results list.

3. Click the computer's name to display the enabled directory.

Note: If a user name and password are requested when you click the computer, the
login name and password used on the computer must be entered.

The files in this directory can be accessed by the instrument.

2.7 Remote Access via an External Controller

The R&S SMATE can be remote accessed from a remote computer (external controller)
via a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.
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For an overview of the instrument's operating concept and the different ways to control
and operate the instrument, see ​chapter 3.1, "Brief Introduction to the Instrument's Con-
cept", on page 53.

There are different ways to establish a remote access connection to the signal generator
but all of them require an established LAN connection between the instrument and the
remote computer. The simplest way to remote access the instrument is to use a Web
browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alternatively
a remote access via a special application can be used.

Two free-of-charge programs are available for setting up the remote access connection:
the Windows application Remote Desktop for PCs with Window operating system and
the program Ultr@VNC for PCs with Linux/Unix or Windows operating system. Using of
each of this two applications requires additional installation.

See the following table for an overview of the different ways to establish a remote access
connection to the signal generator.

Table 2-1: Remote access via an external computer

Remote access via
LAN

connec-
tion

Installation of the additional appli-
cation

on the instru-
ment

on the remote
computer

Web Browser

e.g. Windows Internet Explorer or Mozilla Firefox

see ​chapter 2.7.1, "Using a Web Browser for Remote
Access", on page 36

required no no

Remote Desktop

Windows application for PCs with Window operating sys-
tem

see ​chapter 2.7.2, "Remote Desktop Connec-
tion", on page 37

required no required

Ultr@VNC

for PCs with Linux/Unix or Windows operating system

see ​chapter 2.7.3, "Remote Access via
Ultr@VNC", on page 39

required required VNC Viewer
required

When the connection is set up with Remote Desktop, the device firmware of the signal
generator is disabled. Direct control on the instrument is not possible while manual
remote-control is active. The access of an external PC is indicated by the logon screen
of Windows XP Embedded which identifies the accessing user.

When the connection is set up with Ultr@VNC, direct control on the instrument is possible
while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cutting
the connection, it is still enabled and can be established again any time. The connection
is disabled only after deactivation of the program.

Remote Access via an External Controller
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This section gives an information on how to use the Web browser for remote access, how
to install the applications for remote access and how to establish the connection between
the instrument and an external computer with Windows operating system. Remote
access via an external computer with Linux/Unix operating system is performed accord-
ingly.

Accessing Operating System
The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

Default password
Remote-access and file access require the user "instrument" with default password
"instrument".

2.7.1 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any Web browser, like Windows Internet
Explorer or Mozilla Firefox for instance.

To remote access the instrument via Web browser:

1. Connect the instrument and the remote computer to a LAN, see ​chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 31.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your PC,
e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

4. Enter the password and select "OK".
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The default password is "instrument".

After the connection is established, the current signal generator screen with the block
diagram is displayed and the instrument can be remote-accessed from the remote
computer.

2.7.2 Remote Desktop Connection

Remote Desktop is a Windows application which can be used to access and control the
instrument from a remote computer through a LAN connection. While the instrument is
in operation, the instrument screen contents are displayed on the remote computer, and
Remote Desktop provides access to all of the applications, files, and network resources
of the instrument. Thus, remote operation of the instrument is possible.

Risk of Unauthorized Access
If the Windows Remote Desktop application is enabled on the instrument (go to "Start >
Settings > Control Panel > System"), any user in the network who knows the computer
name and login data can access it. To prevent this, make sure that the Remote Desktop
application on the instrument is disabled.

To set up a Remote Desktop connection

1. Enable remote desktop control on the instrument.

2. Connect the instrument and the remote computer to a LAN, see ​chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 31.

3. Set up the Remote Desktop connection between the remote computer and the instru-
ment.

Remote Desktop Client
With Windows XP, Remote Desktop Client is part of the operating system and can be
accessed via "Start > Programs > Accessories > [Communications >] Remote Desktop
Connection.".
For other versions of Windows, Microsoft offers the Remote Desktop Client as an add-
on.

Enabling remote desktop control on the instrument

1. Press the "Windows" key to access the operating system.

2. Open the Control Panel by selecting "Start > Settings > Control Panel".

3. Select "System" and switch to the "Remote" tab.

4. Under "Remote Desktop", activate the "Allow users to connect remotely to this com-
puter" option.
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Note: Remote Desktop access and firewall settings.
When you enable or disable the Windows Remote Desktop option (in the "System
Properties"), the associated firewall settings are adapted automatically.

5. If necessary, click "Select Remote Users" and select users who are to be given
access to the R&S SMATE via Remote Desktop. The user account under which con-
figuration is carried out is automatically enabled for Remote Desktop.

Setting up the Remote Desktop connection on the remote computer

1. On the remote computer, select "Start > Programs > Accessories > [Communications
>] Remote Desktop Connection."

2. Enter the instrument's name or IP address in the dialog box (see also ​chapter 2.6.2,
"Assigning the IP Address", on page 32).

3. Enter the user ID and password for the instrument (see also ​chapter 2.5, "Windows
Operating System", on page 28).

4. Click "Connect".

When the connection has been set up, the instrument's screen appears on the remote
computer.

Disabled Direct Control
While remote access is active, the direct control of the instrument is disabled.
Remote access is indicated on the instrument by the logon screen of the operating sys-
tem. The logon screen identifies the accessing user.

For simultaneous remote access of several instruments from the same PC, a separate
Remote Desktop session must be opened for each instrument.

For detailed information about Remote Desktop and the connection refer to the Windows
XP Help.

Helpful settings for Remote Desktop

The following settings for the Remote Desktop connection can make working on the
remote PC more convenient.

1. When setting up the connection to the instrument, you can configure the connection
settings in the "Remote Desktop Connection" dialog box.
Click the "Options >>" button.

The dialog box is expanded to display the configuration data.

2. Customize the settings:

● On the "Experience" tab:
– Select the appropriate connection to optimize the connection speed.
– To improve the performance, you can deactivate options you do not require

under "Allow the following".
● On the "Local Resources" tab:
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– If you need to access drives of the remote PC from the instrument (e.g. in
order to store settings or to copy files from the PC to the instrument), activate
the "Disk drives" option. Windows XP will then map drives of the remote PC
to the corresponding network drives. When a connection is established, a
warning is displayed on the PC indicating that the drives are enabled for
access from the instrument.

– To use printers connected to the remote PC while accessing them from the
instrument, activate the "Printers" options. Do not change the remaining set-
tings.

● On the "Display" tab:
– Under "Remote desktop size", set the size of the R&S SMATE window on the

desktop of the remote PC.
– Activate the "Display the connection bar when in full screen mode" option.

A bar showing the network address of the instrument is displayed on the
screen which you can use to reduce, minimize or close the window.

● On the "General" tab:
You can save the connection settings for later use using the "Save As" button.

Terminating Remote Desktop Control

A Remote Desktop connection can be terminated either on the R&S SMATE or on the
remote PC. The connection can be established again any time as long as remote control
is enabled on the instrument. Consider the notice above concerning unauthorized access
due to Remote Desktop!

1. To terminate the connection on the instrument, click "Disconnect" in the remote-con-
trol message menu of the R&S SMATE.

2. To terminate the connection on the remote PC, close the "Remote Desktop" window,
or select "Start > Disconnect".

Disabling Remote Desktop Control

To disable the remote access, deactivate the Remote Desktop on the instrument.

► Under "Remote Desktop", disable the "Allow users to connect remotely to this com-
puter" option and confirm with "OK".

The connection is disabled, it is no longer possible to access the instrument via
Remote Desktop.

2.7.3 Remote Access via Ultr@VNC

Ultr@VNC is an application which can be used to access and control the instrument from
a remote computer through a LAN connection. The program is included in operating sys-
tem Linux/Unix. It is available as a free-of-charge download on the internet for operating
system Window XP (http://www.uvnc.com/download/index.html) and on the instrument's
CD-ROM.
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Risk of Unauthorized Access
If the VNC application is enabled on the instrument, any user in the network who knows
the computer name and login data can access it. To prevent this, make sure that the VNC
server service on the instrument is disabled.

Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see ​chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 31.

2. ​Install the Ultr@VNC application and enable it on the instrument.

3. In the ICF firewall, enable communication on the network via Ultr@VNC program.
See ​"Configuring Internet Connection Firewall for VNC Connection" on page 42.

4. Install the VNC Viewer on the remote computer with Windows operating system, see
​"Installing the VNC Viewer on a Windows PC" on page 43.

5. Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see ​"Setting up the VNC
connection on the Linux/Unix remote computer" on page 44;

b) the remote computer with Windows operating system, see ​"Setting up the VNC
connection on the Windows remote computer" on page 44.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1. Download the program from the internet and copy it to a directory that can be
accessed.

2. On the instrument, shut down firmware using the ALT+F4 key combination.

3. Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.
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a) Select installation of all components.

b) In the "Additional Task Panel", enable all entries.

A successful installation is indicated by a message.

At the same time a warning is displayed stating that a password must be set.

4. Select "OK".

The "Default Local System Properties" panel opens.
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5. Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other set-
tings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with the
operating system. On mouse over, the IP address of the instrument is indicated.
This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Configuring Internet Connection Firewall for VNC Connection

To enable remote access of an instrument in a local network via VNC connection, the
connection must be specifically permitted in the firewall.

1. Press the "Windows" key to access the operating system and select "Start > Settings
> Control Panel > Windows Firewall" to open the "Windows Firewall".

2. Select "Exceptions > Add Program... > Run Ultr@VNC SERVER" and confirm with
"OK".
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3. In the "Exceptions" tab, enable "Run Ultr@VNC SERVER".

Installing the VNC Viewer on a Windows PC

1. Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.

Note: The VNC Viewer program is included in the download for the installation of the
Ultr@VNC program on the signal generator if "Full installation" was selected in the
"Select Component" panel. In this case, the program ultr@vncviewer.exe can
be copied to the Windows PC.

2. Install VNC Viewer program component on the remote computer.

Remote Access via an External Controller
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Setting up the VNC connection on the Linux/Unix remote computer

The VNC program is available per default for Linux/Unix operating systems.

1. Start a Web browser on the remote computer and enter the IP address of the instru-
ment.

2. Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc://192.168.1.1.

A dialog is opened and the password for the remote VNC connection is requested.

3. Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.
In contrast to remote access via Remote Desktop, the direct control of the instrument
is not disabled and the instrument can be controlled from the front panel and via the
remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1. Start VNC Viewer program component on the PC, select "VNC Server" and enter IP
address of the instrument.

2. To initialize the connection, select "Connect".

A message requesting the password appears.

3. Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.
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Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.

Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMATE or
on the external PC. Terminating the connection does not disable it. It can be established
again any time. See the notice above concerning unauthorized access due to VNC con-
nection!

1. Terminate the connection on the R&S SMATE

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. To terminate the connection on the external Linux/Unix PC, close the internet browser
or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".

b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the instru-
ment.

2.8 Using Virus-Protection Software

Virus-protection software Symantec Antivirus 10.1.7.7000 has been successfully tested
for compatibility with the instrument software on R&S Signal Generator.
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However, Symantec Antivirus may affect the behaviour of the instrument in terms of set-
tling time or stability. Symantec Antivirus 10.1.7.7000 has been subjected to detailed tests
with R&S Signal Generator and a page file of 1024 MB. The system remains very reliable.
However, rare impact on the settling time has been experienced ( slight degradations of
settling time in 2% of samples out of specification).

Preparing the Installation of Symantec Antivirus

The installation is performed in the Windows XP operating system.

Accessing Operating System
The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

1. Press the "Windows" key to access the operating system and open the "System"
dialog by selecting "Start > Settings > Control Panel > System".

2. In the "System" dialog, select the "Advanced > Performance > Settings > Change".

3. Enable "Drive D: [DATA]" and "System managed size", confirm with "Set" and close
the dialog.

The Symantec Antivirus program can be installed.

2.9 LXI Configuration

LAN eXtensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ethernet
with the simplicity and familiarity of GPIB.
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Like GPIB, LXI determines and standardizes the way the instrument behaves in a LAN.
The LXI implementation by the R&S Signal Generators allows you to change certain LAN
settings, to reset the LAN connection as well as to easy identificate the instrument.

LXI classes and LXI functionality

LXI-compliant instruments are divided into three classes, A, B and C, with the functionality
of the classes hierarchically based one upon the other:

● Class C instruments are characterized by a common LAN implementation, including
an ICMP ping responder for diagnostics. The instruments can be configured via a
web browser; a LAN Configuration Initialize (LCI) mechanism resets the LAN con-
figuration. The LXI class C instruments shall also support automatic detection in a
LAN via the VXI-11 discovery protocol and programming by means of IVI drivers.

● Class B adds IEEE 1588 Precision Time Protocol (PTP) and peer-to-peer commu-
nication to the base class. IEEE 1588 allows all instruments on the same network to
automatically synchronize to the most accurate clock available and then provide time
stamps or time-based synchronization signals to all instruments with exceptional
accuracy.

● Class A instruments are additionally equipped with the eight-channel hardware trig-
ger bus (LVDS interface) defined in the LXI standard.

For information about the LXI standard refer to the LXI website at http://www.lxistan-
dard.org. See also "News from Rohde & Schwarz, article 2006/II - 190".

Instruments of classes A and B can generate and receive software triggers via LAN mes-
sages and communicate with each other without involving the controller.

The R&S SMATE complies with LXI class C and provides an integrated "LXI Status"
dialog for LXI status indication and reset of the LAN configuration (LAN Configuration
Initialize, LCI). To accesss the LXI Status dialog, press the SETUP key and select
"Remote > LXI Status".

For further information, see section "LXI Status" in the Operating Manual.

LXI Configuration
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Firmware update
After a firmware update, shut-down and re-start the instrument in order to enable the full
LXI functionality.

Default state of the network settings

According to the LXI standard, an LCI must set the following parameters to a default state.

Parameter Value

TCP/IP Mode DHCP + Auto IP Address

Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWebIfc

The LCI for the R&S SMATE also resets the following parameters:

Parameter Value

Hostname <Instrument-specific host name>

Description Vector Signal Generator

Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's "LXI Browser Interface".

2.9.1 LXI Browser Interface

The instrument's LXI browser interface works correctly with all W3C compliant browsers.
Typing the instrument's host name or IP address in the address field of the browser on
your PC, e.g. http://10.113.10.203, opens the "Instrument Home Page" (welcome page).

Do not add the missing zeros in the IP address, while opening the Instrument Home Page.
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The "Instrument Home Page" displays the device information required by the LXI stand-
ard including the VISA resource string in read-only format.

► Press the "Inactive (press to toggle)" button to indicate the device.

Pressing this button causes a LAN Status indicator on the instrument's home page
to flash (if active).
A green LXI status symbol on the instrument's home page indicates that a LAN con-
nection has been established; a red LED indicates that no LAN cable is connected.
The status of the LAN connection is also indicated by the "LAN Status indicator" in
the "LXI Status" dialogbox and by the LXI status LED on the front panel of the instru-
ment.
The "Device Indicator" setting is not password-protected.
For further information, see section "LXI Status" in the Operating Manual.

The navigation pane of the browser interface contains the following control elements:
● "LAN Configuration" opens the LAN Configuration page.
● "LXI Glossary" opens a document with a glossary of terms related to the LXI standard.
● "Status" displays information about the LXI status of the instrument.

2.9.2 LAN Configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

 

LXI Configuration
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The "TCP/IP Mode" configuration field controls how the IP address for the instrument
gets assigned (see also ​chapter 2.6.2, "Assigning the IP Address", on page 32). For the
manual configuration mode, the static IP address, subnet mask, and default gateway are
used to configure the LAN. The automatic configuration mode uses DHCP server or
Dynamic Link Local Addressing (Automatic IP) to obtain the instrument IP address.

Changing the LAN configuration is password-protected. The password is LxiWebIfc
(notice upper and lower case characters). This password cannot be changed in the cur-
rent firmware version.

The links at the bottom of the "LAN Configuration" page open other pages:

● "Ping Client" provides the ping utility to verify the connection between the instrument
and other devices.

● "Advanced LAN Configuration" provides LAN settings that are not declared manda-
tory by the LXI standard.

2.9.2.1 Advanced LAN Configuration

The "Advanced LAN Configuration" menu provides LAN settings that are not declared
mandatory by the LXI standard.
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The "Advanced LAN Configuration" parameters are used as follows:

● The "Negotiation" configuration field provides different Ethernet speed and duplex
mode settings. In general, the "Auto Detect" mode is sufficient.

● "ICMP Ping" must be enabled to use the ping utility.
● "VXI-11" is the protocol that is used to detect the instrument in the LAN. According

to the standard, LXI devices must use VXI-11 to provide a detection mechanism;
other additional detection mechanisms are permitted.

2.9.2.2 Ping

Ping is a utility that verifies the connection between the LXI-compliant instrument and
another device. The ping command uses the ICMP echo request and echo reply packets
to determine whether the LAN connection is functional. Ping is useful for diagnosing IP
network or router failures. The ping utility is not password-protected.

To initiate a ping between the LXI-compliant instrument and a second connected device:

1. Enable "ICMP Ping" on the "Advanced LAN Configuration" page (enabled after an
LCI).

2. Enter the IP address of the second device without the ping command and without
any further parameters into the "Destination Address" field (e.g. 10.113.10.203).

3. Click "Submit".

 

LXI Configuration
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LXI Configuration
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3 Getting Started
This section helps you to get familiar with the R&S SMATE and provides an introduction
to the general concept of the instrument with a sample of the possible application fields
as well as a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

3.1 Brief Introduction to the Instrument's Concept

The R&S SMATE provides an entirely digital baseband section for generating I/Q signals
and an RF section with I/Q modulator. The instrument uses I/Q (vector) modulation. Dig-
ital data streams are converted to an I/Q baseband signal. The baseband signal is then
D/A-converted and modulated onto the target RF carrier frequency with the aid of an I/Q
modulator.

The R&S SMATE may contain two paths; through the user docmentation, the first being
is called path A and the second path B, respectively.

The R&S SMATE is primarily intended to be remote-controlled via the GPIB interface or
a LAN connection. Alternatively it is possible to control the instrument manually using an
external monitor in combination with a mouse and keyboard or by accessing the instru-
ment via the remote control desktop of an external PC.
In the following, the indications of the user interface on the external monitor are used to
explain the functions of the vector signal generator .

For a detailed description of the blocks in the baseband and RF sections, refer to ​chap-
ter 3.3, "Baseband Section", on page 59 and ​chapter 3.4, "RF Section", on page 61
respectively.

The operating concept of the R&S SMATE employs the following three ways of instru-
ment control:
● Manual operation
● Remote control
● Remote access

Manual Operation

The architecture of the R&S SMATE and the signal flow can be displayed in a block
diagram on an external monitor connected to the instrument.
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The R&S SMATE is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.

The block diagram in the figure below shows a fully equipped instrument.

Fig. 3-1: Block diagram of a fully equipped R&S Signal Generator

The instrument comprises a comprehensive info and help system. Context-sensitive help
can be called any time with the HELP (F1) key. The help system indicates the currently
selected parameter and offers additional services such as cross references, index and
contents. The content of the help system corresponds to the operating manual of the
instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be reques-
ted from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table is
modified only after the "Accept" button has been pressed. Pressing the "Accept" button
also stores the assistant data.

For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to ​chapter 4, "Manual Opera-
tion", on page 71.

For an indepth description of the dialog boxes and the instrument functions refer to sec-
tion "Instrument Functions" in the Operating Manual.

Remote Control

Remote control is an operation of the instrument by means of remote control commands
or programs that automatize repeating settings. The instrument is connected to a com-
puter running the program.

Brief Introduction to the Instrument's Concept
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This way of operation and the instructions how to set up a connection for remote control
are described in the Operating Manual, chapter "Remote Control Basics". The description
of the remote control commands is provided in the Operating Manual, chapter "Remote
Control".

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the R&S
SMATE and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be oper-
ated from the remote computer as on the unit itself. The individual functions are operated
using the mouse and keyboard. Specific instrument functions can be executed using
specific key combinations on the keyboard or a front panel key emulation that can be
operated with the mouse.

This way of operation and the instructions how to set up a connection for remote access
are described in ​chapter 2.7, "Remote Access via an External Controller", on page 34.

3.2 Applications of the Instrument

The modular design of the R&S SMATE allows the instrument to be equipped with two
paths. This allows a multitude of applications to be performed for which several signal
generators were previously required. A few examples are given below.

3.2.1 Generation of digitally modulated signal

The main field of application of the R&S SMATE is the generation of digitally modulated
signals. In the instrument, a digitally modulated signal can be generated in several ways.

Internally generated I/Q signal

The I/Q signal is generated internally in the R&S SMATE. One or two baseband gener-
ators can be installed. The signals produced by the two generators can be added (pos-
sibly with frequency offset).

In this case the instrument must be equipped with
● at least one baseband generator (option R&S SMATE-B10/B11) and
● at least one baseband main module (option R&S SMATE-B13).
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Fig. 3-2: Operation of I/Q modulator with I/Q signals from the internal baseband section

Analog Wideband I/Q operation

An external analog I/Q signal is directly applied to the I/Q modulator of the R&S SMATE.
In this mode, the entire bandwidth of the I/Q modulator can be utilized. The various capa-
bilities of the baseband section (AWGN, addition of signals, etc) are disabled, however.

Fig. 3-3: Operation of I/Q modulator with external analog I/Q signals directly applied to the I/Q modulator

3.2.2 Two Baseband Generators, One RF Path

Examples of the possible applications of an instrument equipped with two baseband
generators and one RF path are:
● Addition of real time signals of different standards, e.g. GSM/EDGE and 3GPP FDD
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● Generation of multicarrier signals with real time components
● Simulation of antenna diversity

Fig. 3-4: Operation of R&S Signal Generator with two baseband generators and one RF path

3.2.3 One Baseband Path and Two RF Paths

An examples of the possible applications of an instrument equipped with one baseband
path and two RF paths is:
● Generation of a modulated signal on path A and a CW interferer on path B.

Fig. 3-5: Operation of R&S Signal Generator with one baseband generator and two RF paths
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3.2.4 Two RF Paths

Examples of the possible applications of an instrument equipped with two RF paths are:
● Combination of an external ARB signals on path A and a CW local signal on path B
● Combination of two external ARB signals, one on path A and one on path B

Fig. 3-6: Operation of R&S Signal Generator with two RF paths

3.2.5 Fully Equipped Two-Path Instrument

Examples of the possible applications of a fully equipped two-path instrument are:
● Generation of a wanted signal and an interfering signal for receiver tests
● Generation of multicarrier signals with extremely wide bandwidth (>80 MHz)

Fig. 3-7: Fully equipped two-path instrument
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3.3 Baseband Section

The baseband section of the R&S Signal Generator is fully digital and contains the hard-
ware for generating and processing I/Q signals.

The baseband section may contain two paths.

For detailed information on available options, refer to the R&S SMATE data sheet and
the R&S SMATE configuration guide.

Up-to-date information is available at R&S SMATE homepage on the internet http://
www2.rohde-schwarz.com/product/smate200a.html.

Baseband generator (option R&S SMATE-B10)

The generator produces baseband signals. It contains modules for real time signal gen-
eration and an arbitrary waveform generator (ARB).

The different baseband options feature a different ARB memory size (see data sheet).
But apart from the memory size, all options have the same functionality and are installed
alternatively.

One or two baseband generators can be fitted in an R&S SMATE and operated sepa-
rately. Signals from the baseband generators can be routed from path A to B and vice
versa, and added (possibly with frequency offset).

The option Baseband Generator contains real time Custom Digital Modulation and ARB.
Software options providing various digital standards are offered in addition. Option R&S
SMATE-K40, for instance, generates signals to GSM/EDGE standard, option R&S
SMATE-K42 signals to 3GPP FDD standard.

Baseband main module (option R&S SMATE-B13)

The baseband main module can be installed twice, for each of both paths A and B
respectively.

At the end of the baseband path, the digital signal is converted to an analog I/Q signal.
The analog I/Q signal is fed to the I/Q modulator of the RF path. This module also routes
signals to the analog I/Q outputs. The module is absolutely required for coupling out the
baseband signal from the baseband section.

At this stage routing from A to B or vice versa is no longer possible. If a two-path RF
section is available, two baseband main modules are required if the signals from the
baseband section are to be output to the two RF paths.

This module also offers digital I/Q impairment functions. The I/Q signal can be deliberately
corrupted, e.g. for testing the receiver quality.

Additional White Gaussian Noise (option R&S SMATE-K62)

Additive white noise, which may be required for instance for measurements on mobile
radio base stations, can be produced with the AWGN software option (R&S SMATE-K62).

 

Baseband Section
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3.3.1 Description of Individual Diagram Blocks of the Baseband Section

The baseband section of the R&S SMATE comprises two paths (paths A and B). There-
fore, if two baseband generators are available, two baseband signals can be processed
independently of each other. Routing from path A to path B and vice versa is also possible,
but not after the "IMP" or "AWGN/IMP" block.

Each function block can be activated or deactivated with the "ON" check box (on/off tog-
gling).

A detailed description of the blocks is provided below.

Baseband A block
In this block, the (first) baseband source is configured and activated. The block is dis-
played only if a baseband generator is available in the instrument.

Depending on the installed software options, various digital standards, user-configured
digital real time modulation or the built-in waveform generator (ARB) can be selected.
The selected modulation is displayed in the block.

The TOGGLE ON/OFF key switches the selected modulation (digital standard, digital
modulation or ARB) on or off.

Baseband B block
Configures the second baseband source (if installed). The block is displayed only if the
instrument contains two baseband generators. Depending on the installed software
option, various digital standards, user-configured digital real time modulation or the built-
in waveform generator (ARB) can be selected.

Note: If two baseband generators are installed and two signals of the same standard
(e.g. GSM/EDGE) should be output simultaneously, the two associated software options
must also be installed (in this case R&S SMATE-K40).
If only one R&S SMATE-K40 is installed and GSM/EDGE is selected in the first baseband
generator, the second baseband generator is disabled for GSM/EDGE.
However, a software option is not tied to a specific baseband generator. In our example,
either the first or the second baseband generator can output a GSM/EDGE signal.

AWGN/IMP A block
This block is displayed only if a baseband main module is installed.

In this block (digital) I/Q impairments for the baseband path can be set. With the aid of
the software for AWGN generation (option R&S SMATE-K62), an (additive) noise signal
can be produced.

AWGN and impairments can be activated independently of each other in the appropriate
menus. The settings are displayed in the block. The entire block can be activated or
deactivated. If the block is deactivated, the signal passes through the block unchanged.

In addition, the differential I/Q output is configured in this block (option R&S SMATE-B16).

The TOGGLE ON/OFF key switches the active functions of the block on or off. The func-
tions (AWGN, impairments or both) are activated in the respective menus.
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AWGN/IMP B block
This block is displayed only if two baseband main modules (option R&S SMATE-B13)
are installed. In this block (digital) I/Q impairments for baseband path B can be set. With
the aid of the software for AWGN generation (option R&S SMATE-K62), an (additive)
noise signal can be produced in path B.

If a noise signal should be applied to path A and B simultaneously, two software options
R&S SMATE-K62 are required.

Graphics block
With this block, the baseband signal (of path A or B) can be graphically displayed in real
time. The block is displayed only if at least one baseband main module is installed.

The TOGGLE ON/OFF key opens or closes the graphics window.

3.4 RF Section

The RF section of the R&S SMATE may also contain two paths.

An RF path is configured by installing a frequency option that comprises all required
modules.

One of the following options must be installed.

Frequency options (Path A)
● R&S SMATE-B103 (up to 3 GHz)
● R&S SMATE-B106 (up to 6 GHz)

Frequency options (Path B)
● R&S SMATE-B203 (up to 3 GHz)
● R&S SMATE-B206 (up to 6 GHz)

RF path B can be I/Q-modulated only if the baseband section is equipped with two Base-
band Main Modules R&S SMATE-B13.

In addition, each RF path can be equipped with
● high-power option for higher output levels (R&S SMATE-B31/B36)
● option FM/PhiM Modulator and Low Phase Noise (R&S SMATE-B20/B22)

For detailed information on available options, refer to the R&S SMATE data sheet and
the R&S SMATE Configuration guide.

Up-to-date information is available at R&S SMATE homepage on the internet http://
www2.rohde-schwarz.com/product/smate200a.html).
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3.4.1 Description of Individual Diagram Blocks of the RF Section

This section gives an overview of the available blocks and a detailed descritption of their
functions.

I/Q Mod A block
The (first) I/Q modulator is configured in this block. Also the Analog Wideband I/Q mode
can be selected here, which allows external I/Q signals to be directly applied to the I/Q
modulator, i.e. not via the baseband section. If no baseband modules are installed, I/Q
modulation is possible only in the Analog Wideband I/Q mode.

I and Q components can also be swapped (I/Q Swap). (Analog) I/Q impairments can be
set in addition. Unlike the impairments in the "AWGN/IMP" block, impairments in the "I/
Q Mod" block also affect the externally applied signals in the Analog Wideband I/Q mode.

The status display in the block shows whether I/Q impairments and/or I/Q swap is active.
I/Q modulation is switched on or off with the TOGGLE ON/OFF key.

Note: An I/Q modulator provided in the R&S SMATE is automatically activated when a
connected baseband source is switched on. The I/Q modulator can also be separately
switched on and off (select the "I/Q Mod" block and press the TOGGLE ON/OFF key).
This permits the following configuration to be obtained with a single-path R&S SMATE.
The baseband source generates an I/Q signal that is output via the analog I/Q output. At
the same time, the RF section generates an unmodulated carrier.

I/Q Mod B block
This block controls the I/Q modulator of RF path B. It is displayed only if a second RF
path is installed.

Note: The I/Q modulator B can be driven by modulation signals from the R&S SMATE
baseband section or by external analog I/Q signals

RF/A Mod A block
In this block, the RF parameters and the analog modulation modes of path A are set.

The active analog modulation modes are displayed in the block. The TOGGLE ON/
OFF key switches the RF signal on and off. When the RF signal is switched off, the switch
before the RF output symbol is open.

RF settings include:
● Frequency and reference frequency
● Attenuator settings.

If required, switching to the high-power mode if a high-power option is installed for
path A.

● Frequency and level sweep
● List Mode settings. In this mode, extremely fast frequency and level settings can be

made.
Note: Numeric values for frequency and level are entered best and quickest with the aid
of the FREQ and LEVEL keys.
Available analog modulation modes:
● Amplitude modulation
● Broadband amplitude modulation
● Frequency modulation (option R&S SMATE-B20/B22)
● Phase modulation (option R&S SMATE-B20/B22)
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● Pulse modulation.
Note: For modulation modes that can be simultaneously used, refer to the R&S SMATE
data sheet.

RF/A Mod B
In this block, settings are made for analog modulation and RF parameters of path B. This
block is displayed only if a second RF path is installed.

Available analog modulation modes:
● Amplitude modulation
● Frequency modulation (option R&S SMATE-B20/B22)
● Phase modulation (option R&S SMATE-B20/B22)
● Pulse modulation.

3.5 Example of Setup

This section provides an example on how to configure the instrument to generate and
display a simple QPSK-modulated signal.

The example assumes that an external keyboard is connected to the instrument (see ​
chapter 2.4, "Connecting External Accessories", on page 26 ).

Configuring and displaying a QPSK-modulated signal

To generate and display a QPSK-modulated signal, proceed as follow:

1. Activate default (preset) state.
Press the CTRL+P combination on the external keyboard to set a defined instrument
state.
SCPI command: *RST
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2. Select and activate digital modulation

a) Use the cursor keys on the external keyboard and select the "Baseband A" block.
SCPI command: n.a.

b) Press the ENTER key to open the menu where the digital modulation can be
selected (different modulation modes are available depending on the options
installed).
SCPI command: n.a.

Example of Setup
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c) Use the cursor key to navigate and highlight "Custom Digital Mod...".

Press the ENTER key to open the "Custom Dig. Mod." dialog.
SCPI command: n.a.

d) Use the cursor keys to navigate and to select parameter "Symbol Rate" and enter
the preferred symbol rate with the aid of the numeric keys.
SCPI command: SOUR:BB:DM:SRAT 10MHz

Example of Setup
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e) Use the cursor keys to navigate and to select parameter "Coding".
Press ENTER to open the selection list.
Use the cursor keys to select "Off" and press ENTER to activate the selected
item.
SCPI command: SOUR:BB:DM:COD OFF

f) Use the cursor keys in the same way to set "Modulation Type" QPSK and "Fil-
ter" Root Cosine with "Roll Off Factor" 0.3.
SCPI command: SOUR:BB:DM:FORM QPSK
SOUR:BB:DM:FILT:TYPE RCOS
SOUR:BB:DM:FILT:PAR:RCOS 0.3

Example of Setup
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g) Finally, select "State" and press ENTER to switch on the digital modulation.
SCPI command: SOUR:BB:DM:STAT ON

h) Press the CTRL+D key combination to display the complete block diagram.
SCPI command: n.a.

To indicate the active state, the "Baseband" block is displayed in blue.

Example of Setup
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i) The entry in the "Winbar" indicates that the "Custom Dig. Mod." menu is still open
in the background.
To display the menu in the foreground, press the ESC key.

Press the CTRL+H key combination to minimize the menu again.
Press the ESC key again to close the dialog.
SCPI command: n.a.

The "I/Q Mod" block is automatically activated.
The "RF/A Mod" is not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

a) Press the CRTL+F key combination to activate the editing mode for frequency
entry. The "Frequency" entry field in the header section of the display is high-
lighted.

Enter the frequency using the numeric keys and terminate the entry by pressing
the ALT+F9 key combination for unit GHz.
SCPI command: SOUR:FREQ 2E9

b) Press the CTRL+L key combination and enter the level settings in the same way.
SCPI command: SOUR:LEV -5dBm

c) Press the CTRL+D key combination to display the complete block diagram.
d) Select the "RF/A Mod" block and activate it.

SCPI command: OUTP:STAT ON
The QPSK modulation signal is now present at the RF output.

Example of Setup
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4. Select graphics display of I/Q signal

a) Select the "Graphics" block and open the respective menu.

b) Select "State On" to activate display of the I/Q diagram.

Example of Setup
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4 Manual Operation
The following chapter describes the manual control of the R&S SMATE is provided even
though the instrument is primarily intended to be remote-controlled via the GPIB interface
or a LAN connection. Manual control using an external monitor, mouse and keyboard or
from an external PC via a network link might help the user to get familiar with the instru-
ment.

The examples whitin this description focus on manual operation from an external monitor
with an external keyboard connected to the instrument.

The introduction into remote control is provided in ​chapter 5, "Remote Control
Basics", on page 109.

The R&S SMATE can be operated manually either via the interactive block diagram or
via a menu tree. All menus are in the form of windows that can be operated in the same
way. Key combinations on the external keyboard or alternatively a mouse allow direct
access to entries and settings.

A key emulation menu can be called from the Window XP operating system (see ​chap-
ter 4.1.2, "On-screen Keyboard", on page 73). Thus, operation via mouse only is pos-
sible. This is supported by an R&S SMATE specific key emulation that emulates the front
panel function keys of the R&S®SMU200A. The R&S SMATE-specific key emulation is
called by a right-click of the mouse. For an overview of the key combinations, refer to ​
chapter 4.1, "Legend of Manual Controls", on page 71.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog boxes
and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to sec-
tion "Instrument Functions" in the Operating Manual.

4.1 Legend of Manual Controls

The following table lists all available key combinations used on the PC keyboard to trigger
functions on the instrument. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 4-1: Overview of the keyboard key combinations and their function

Key of PC keyboard Short description Function

. / *...# Special characters Enters a special character, e.g. period/dec-
imal point.

+/- Sign Enters the sign.
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Key of PC keyboard Short description Function

- / (shift+) a—z A<->a Switches between upper-case and lower-
case letters.

ALT + F9 Units G/n / dBuV / dBu Selects the unit Giga/Nano, dBuV for the RF
level and dBu for the LF level.

ALT + F10 Units M/u / uV Selects the units Mega/Micro and uV for RF
levels.

ALT + F11 Units k/m / uV Selects the units Kilo/Milli and uV for RF lev-
els.

ALT + F12 Enter function

Unit dBm

Confirms entries in the base unit and values
without a unit.

Selects dBm for the RF level and dB for level
offset and level step width.

Arrow keys Cursor Moves the cursor.

Backspace Clears entry Clears the last entry (number, sign or deci-
mal point)

CTRL + A Rearrange Arranges open dialogs automatically

CTRL + C Recalculate Starts recalculation of the signal.

CTRL+ D Block diagram Sets the cursor on the block diagram and
hides all menus.

CTRL + E Setup menu Opens the setup menu for general instru-
ment settings.

CTRL + F1 – F8 Softkey 1 – 8 Triggers the function assigned to the soft-
key.

CTRL+ F Frequency Activates the frequency entry.

CTRL + G Closes menus Closes an active menu.

CTRL+ H Hide Minimizes the active menu. Pressing the
respective button in the Winbar opens the
menu again.

CTRL + I Info Opens/closes the info window

CTRL + L Level Activates the level entry.

CTRL + M Menu Calls the menu selection list.

CTRL + O Modulation on/off Switches modulation on/off. "MOD OFF" is
indicated in the status line.

CTRL + P Preset Restores a defined basic instrument setup.

CTRL + Q Local Switches the instrument from remote control
to manual control.

CTRL + R RF on/off Switches the RF output signal on/off. "RF
OFF" is indicated in the status line. Both RF
output signals are always deactivated in the
case of two-path instruments.

CTRL + S Storage under Windows Activates the menu for storing instrument
settings.

Legend of Manual Controls
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Key of PC keyboard Short description Function

CTRL + T Toggle on/off Switches a block or parameter on/off.

Toggles between the different possibilities
of setting a selection parameter.

CTRL+ Y Hardcopy Opens the menu for configuring and starting
a hardcopy.

CTRL + W Winbar Displays the Winbar in the foreground/back-
ground.

Enter Enter Terminates an entry.

ESC ESC Selects the next higher menu/selection
level. When the editing mode is exited with
ESC, the previous value is restored.

F1 Help Opens/closes context-sensitive help.

Ins Insert Activates the insert mode.

4.1.1 Front Panel Key Emulation

The R&S SMATE provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called on the
external monitor by a right mouse click. The front panel key functions are executed by a
mouse click on the associated button.

4.1.2 On-screen Keyboard

In addition, the Windows XP operating system provides a keyboard emulation that can
be used for system settings if no external keyboard but a mouse is available.

To access the on-Screen Keyboard, select "Start > Programs > Accessories > Accessi-
bility > On-Screen Keyboard".
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4.2 Key Features

The manual operating concept of the R&S SMATE enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteristics
of the generated signal and of the current instrument state. Numerous online help func-
tions support user settings.

Block diagram

The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is pressed.

Permanent frequency and level display

The main characteristics of the RF signal, frequency and level, are permanently displayed
in the header section of the screen and can be directly set in the display fields after the
FREQ (CTRL+F) or LEVEL (CTRL+L) key is pressed. Status messages for the output
signal are displayed in addition to frequency and level.

Operation via Graphical User Interface

● Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The function
blocks represent elements of signal generation. Function blocks displayed with a blue
frame can be directly switched on and off by means of the TOGGLE ON/OFF (CTRL
+T) key. The menus of the highlighted function blocks can be called by pressing the
ENTER key.
– Example:

The "Baseband" block contains all menus required for baseband signal configu-
ration.
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In this block all digital standards and the digital modulation can be selected.

● Signal flow
The signal flow between the function blocks and the employed inputs and outputs are
also shown.

● Menu tree
The menu tree can be opened and closed with the MENU (CTRL+M) key. The menu
tree is organized in the same way as the directories under Windows. The function
blocks correspond to the first directory level, the menus to subdirectories.

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Windows
user interfaces. All menus and tables are made up of known elements, such as selection
lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element, entries
can be made.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be operated
independently of each other, i.e. none of the dialogs requires that settings in other dialogs
be completed before it can be closed. This ensures flexible operation at all times.

Key Features
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Winbar

The Winbar gives an overview of menus and simplifies their access.

The menus are displayed on top of the block diagram but they can be "hidden" with the
aid of the HIDE (CTRL+H) key, i.e. displayed in the form of a button in the "Winbar" at
the lower end of the screen.

They can be displayed again in full size by a keystroke (REARR (CTRL+A) key). This
makes room on the screen for other displays that may be required but the setting menus
can be still accessed any time.

Keys with assigned simple functions

Most key combinations directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the RF ON/OFF (CTRL
+R) key the RF output signal can be switched on or off.

An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
menus for general instrument settings or the FILE (CTRL+S) key which opens the menu
for file management.

Help functions for user support

Numerous help functions support the user in signal configuration.

● Value ranges
The valid setting range is displayed for each numeric parameter. This requires a short
wait after activation of the entry field. The range is then displayed automatically after
a few seconds.

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

● Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

Key Features
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● Comprehensive online help
Each help page is part of a comprehensive online help function which can be called
by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
HELP (F1) key.

Graphical display of data structure

The structure of the baseband signal is graphically displayed in the respective menus;
the individual signal elements can be graphically selected for processing.

Graphics editor for definition of control signals

Control signals are also graphically configured.

Key Features
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Graphical display of output signal in a diagram

The output signal can be graphically displayed in a number of diagrams. This allows a
fast check of signal characteristics. Zoom functions and the insertion of a reference trace
permit in-depth evaluation without an external analyzer being required.

4.3 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:
● The frequency and level display with info line indicates the main output signal param-

eters and reports the current state with status, error and warning messages.
● The block diagram shows the instrument configuration, the signal characteristic as

well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

● Winbar with labelled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.
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Fig. 4-1: Block diagram of a fully equipped R&S Signal Generator

4.3.1 Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see ​chapter 4.3.2, "Status Infor-
mation and Messages", on page 79) are displayed in the header field of the screen.
The display may vary depending on the instrument's operating mode:
● In the case of two-path instruments, the RF information for the two paths is displayed

in two lines.
● In the sweep mode, the current frequency or level of the output signal is displayed.

The status message "SweepMode" is displayed in the info line.
● In the list mode, neither the current frequency nor level is displayed, the indication is

dimmed.
● If user correction is active, the status message "UCorr" is displayed in the info line.
● In the case of digital modulation, "Freq" indicates the frequency, "PEP" the peak

envelope power and "Level" the average level.

The value displayed in the "Freq" and "Level" field does not consider any offset set or
multiplier factor.
For more information see "RF Frequency and Phase" and "RF Level" in the Operating
Manual.

4.3.2 Status Information and Messages

The status information and messages are displayed in the header section of the screen.
The messages differ with respect to their importance (errors, warnings, info) and the time
of their appearance (brief and permanent messages). They require different treatment
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by the user. Further information on all messages can be called in the info window (see ​
chapter 4.3.3, "Info Window", on page 81).

Refer to "Error messages" in the Operating Manual for an overview of all status informa-
tion and messages as well as instructions for error elimination.

4.3.2.1 Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
info line or in the info line itself.

On two-path instruments, all states that can occur independently in the two paths are
displayed separately for each path. The associated path is indicated in the info line.

4.3.2.2 Messages

Messages indicate errors in the instrument. They are displayed in the info line in different
colors depending on their importance and display duration. Errors (e.g. no calibration
data) are displayed in red, information (e.g. file not found) and warnings in black. Warn-
ings indicate less significant errors (e.g. the instrument operates outside specified data).

4.3.2.3 Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background. They
are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

These messages can be read from remote using SYST:ERR? or SYST:ERR:ALL?.

4.3.2.4 Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in the
info line. After error elimination, the message automatically disappears and is also recor-
ded in the history.
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These messages can be read from remote using SYST:SERR?.

4.3.3 Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev" column
(Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.

Del. volatile
Clears all volatile messages.

This button is available only if the history of the messages is displayed.

SCPI command: 
SYST:ERR:ALL?
Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the same
time cleared.
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History
Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

SCPI command: 
SYST:ERR? or STAT:QUE?
Each time a SYST:ERR? or STAT:QUE? query is sent, the oldest entry in the error queue
is returned and at the same time cleared in the list.

4.3.4 Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation can
be completely operated from the block diagram. The highlighted function block can be
directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the Enter
opens the associated setting menu.

4.3.4.1 Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activated/
deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block is dis-
played in blue. Status information is displayed below the check box. It is different for the
different blocks.

Pressing the Enter key opens the associated setting menu.

In all function blocks where the signal flow can be influenced, the top menu level for setting
signal routing parameters is offered.
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Example: Baseband block

In this block, the digital modulation signal, the digital standards, arbitrary waveform gen-
eration and multicarrier CW are set. The status information of the "Baseband" block indi-
cates the selected modulation and associated additional information, e.g. the number of
channels.

4.3.4.2 Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and outputs
of the signal generator. Unused inputs and outputs are not shown. The lines indicate the
signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example: 

The symbols indicate the inputs for the analog I and Q signal.

In case of configurable user inputs/outputs, the name and the current assignment are
indicated: Marker signals 1 to 3 of the two paths are assigned to fixed output User 1
interface, configured as output for the clock signal of path B.

If several markers are active, the marker characteristics are listed next to the marker
symbol of the active markers.

Symbols and lines are displayed in different colors depending on their function.
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● The baseband signal is indicated by a three line arrow, the I- and Q-components of
the signal by a single-line arrow.

● Addition of signals is indicated by the summation sign.
● Connections are indicated by a "solder point".
● Black is used for the generated signal.
● Green is used for control signals.

The signal flow is configured in the individual menus. User interfaces are configured in:
● the "Setup > USER Marker /AUX I/O Settings" dialog and
● the "Setup > Global Trigger/Clock/External Inputs" dialog.

4.3.5 Winbar and Softkeys

The "Winbar" with eight buttons is displayed below the block diagram. Labelled buttons
represent open menus, the label indicates the menu. If several menus are open, the
button of the currently active menu is displayed in a lighter colour. The buttons also assign
functions to the softkeys of the next lower level for front-panel operation. Up to eight
menus may be open simultaneously. When the ninth menu is opened, the menu that was
opened first is automatically closed.

Some menus, e.g. data and list editor menus, cover the "Winbar" and assign menu-spe-
cific functions to the front-panel softkeys by way of the menu buttons.

Any of the open menus can be activated either with the respective button in the "Win-
bar" or the front-panel softkey. In combination with the keys for menu operation
(CLOSE (ESC), HIDE (CTRL+H) and REARR (CRTL+A)), convenient menu operation
can be ensured.

Working with menus and dialog boxes is described in ​chapter 4.4, "Accessing Dia-
logs", on page 86.

4.3.6 Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function blocks
in the diagram or by means of the MENU (CTRL+M) key. The menus are displayed on
top of the block diagram.

If the menu buttons assign menu-specific functions to the softkeys, the "Winbar" is hidden.

Working with menus and dialog boxes is described in ​chapter 4.4, "Accessing Dia-
logs", on page 86; the setting of parameters in ​chapter 4.5, "Setting Parame-
ters", on page 87.

The menus are in Windows format. The menus differ in details depending on their function
but they consist of the same main elements. Each menu consists of a menu header and
one or more menu areas with various fields for setting parameters.

 

 

Display



Manual OperationR&S®SMATE200A

85Quick Start Guide 1401.0933.69 ─ 07

The header line contains the name of the menu and the buttons for minimizing and closing
the menu. To operate the buttons, use the mouse or the front keys HIDE (CTRL+H) and
CLOSE (ESC).

Several fields of associated but separately set parameters are organized in menu areas.
A menu area is framed and labelled with the function common to all parameters.

Example: Impairments

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

4.3.7 Graphical Display of Output Signal Characteristics

The graphical display of the output signal enables the user to rapidly check signal char-
acteristics without connecting an analyzer. Zoom functions and the display of a reference
trace allow in-depth evaluation. The diagram is displayed on top of the block diagram. It
can be minimized and called in the same way as a menu.

Example: I/Q diagram

To access the "Graphics Settings" dialog for selecting the graphics display of the output
signal, select the "Graphics" function block in the diagram or press the MENU (CTRL+M)
key.

Operation of the graphics windows is analogous to menu operation.
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The menu and the individual graphical displays are described in "Graphics Display" in
the Operating Manual.

4.4 Accessing Dialogs

The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the Winbar buttons or front-panel softkeys
or to use the HIDE (CTRl+H), CLOSE (ESC), DIAGRAM (CTRL+D) and REARR (CTRL
+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

1. Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized and displayed in the form of Winbar buttons.

2. Press the associated softkey (CTRL+F1 .. F8) to display the dialog in the foreground
again.

Accessing the menu tree

► Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File, Setup or Hardcopy dialogs

► Use the FILE (CTRL+S), SETUP (CTRL+E) or HCOPY (CTRL+Y) keys to open the
respective dialog.

Minimizing an active menu

► Use the HIDE (CTRL+H) key to minimize an active menu.

It is displayed in the form of a Winbar button.

Automatically arranging displayed menus

► Press the REARR (CTRL+A) key to rearrange all open menus so that they overlap
as little as possible.

Activating the Windbar

► Use the WINBAR (CTRL+W) key to toggle the cursor between a button of the "Win-
bar" and the block diagram.

The button that was active last in the Winbar is highlighted.

Closing an active menu

► Press the CLOSE key to close an active menu.
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Tip: If the cursor is at the highest menu level, you can also use the ESC key to close
the active menu.

Accessing the header area

► Press the FREQ (CTRL+F) and LEVEL (CTRL+L) keys to activate the "Frequency"
or "Level" entry fields in the header area.

Keyboard Shortcuts
For an overview of all keyboard shortcuts, see ​table 4-1.

4.5 Setting Parameters

The R&S SMATE offers several and sometimes alternative possibilities for setting param-
eters. Manual operation is possible with the aid of a mouse and/or from an external key-
board.

The examples whitin this description focus on manual operation from an external monitor
with an external keyboard connected to the instrument.

For more information, refer to:
● ​chapter 4.1, "Legend of Manual Controls", on page 71 for an overview of the keyboard

shortcuts
● "Instrument Functions" in the Operating Manual for a detailed description of key

functions.

Most of the parameters are set in the different menus. The R&S SMATE provides alter-
native ways for accessing the dialogs. Use the arrow key on the external keyboard and
navigate to the corresponding block in the block diagram and press Enter to open the
dialog or perform a mouse click on the "Config..." button.

An exception are the "Setup", "File" and "Hcopy" dialogs. In the "Setup" dialog, general
settings are made which are not directly concerned with signal generation, e.g. setting of
the GPIB-bus address. In the "File" dialog, files and lists are managed; in the "Hcopy"
dialog, printout is configured and hardcopies can be made. These menus can only be
called with the SETUP (CTRL+E), FILE (CTRL+S) and HCOPY (CTRL+Y) keys.

Frequency and level are directly set in the header area of the display using the FREQ
and LEVEL keys.

Specific settings can also be made directly in the block diagram, e.g. activating a function
block by means of the TOGGLE ON/OFF (CTRL+T) key or switching the RF output on
and off with the aid of the RF ON/OFF (CTRL+R) key. Changes affecting the signal flow
are immediately visible in the graphics display.
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The R&S SMATE uses the Windows XP® operating system. Settings at system level are
only rarely required, e.g. installation of a new printer driver. For convenient operation of
Windows XP®, a keyboard and a mouse are required.

This section provides an information about the parameter handling that comprises of the
following main steps:
● ​chapter 4.5.1, "Working with the Cursor", on page 88
● ​chapter 4.5.2, "Selecting a Control Element", on page 89
● ​chapter 4.5.3, "Switching Parameters On/Off", on page 89
● ​chapter 4.5.4, "Entering a Value", on page 89
● ​chapter 4.5.5, "Working with Units ", on page 91
● ​chapter 4.5.6, "Selecting a Value from a List", on page 91
● ​chapter 4.5.7, "Terminating Entries with Confirmation", on page 92
● ​chapter 4.5.8, "Restoring the Previous Value", on page 93

4.5.1 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of the
diagram (default setting).

Moving the cursor on the display

► To move the cursor, use one of the following alternative methods:

a) Use the arrow keys on the external keyboard.
b) Use the appropriate softkeys (CTRL+F1..F8) to move the cursor to the "Win-

bar".
If the "Winbar" is covered by a menu, press the WINBAR (CTRL+W) key to display
it in the foreground.

c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor position.
The function of this key depends on the current cursor position.
● Calls the next higher selection level.
● Closes the open window without accepting new entries; the old value or param-

eter is retained.
● In dialog boxes that contain a "Cancel" button it activates that button.
● Closes all kinds of dialog boxes, if the edit mode is not active.
● Quits the edit mode, if the edit mode is active.
● Switches between different entry fields of a menu.
● Shifts the entry cursor from the header display to the previously active menu, or

to the previously highlighted block in the block diagram if no menu is active.
● Shifts the cursor from a function block in the diagram to the first item in the

"Winbar". If no menus are open, the current cursor position remains unchanged.
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Moving the coursor to the heading area

► Press the FREQ (CTRL+F) or LEVEL (CTRL+L) key to move the cursor to the header
area.

4.5.2 Selecting a Control Element

Control elements are always selected in the same way no matter whether a function block
in the diagram, a menu in the menu tree, a parameter in the menu or an entry in a list or
table is concerned.

► To activate an element, put the cursor on it.

An active element is highlighted by a blue frame.

4.5.3 Switching Parameters On/Off

A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.

2. To change the state of a parameter, use the "Enter" function of the different control
media:

● Press ENTER
● Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

4.5.4 Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing mode,
cursors of different colour are used. A blue cursor indicates the overwrite mode, a green
cursor the insert mode.

Numeric and alphanumeric values can either be newly entered or the existing value can
be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value

1. Select the parameter.

2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the Enter key to activate the editing mode.
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If the cursor is placed at the right of the total value, the insert mode is always active.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

Editing a value in the overwrite mode

1. Activate the editing mode.

2. Set the cursor on the numeric digit to be changed using the LEFT/RIGHT arrow keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

3. Click on a numeric key to overwrite the highlighted value.

Varying a value

1. Activate the editing mode.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The value at the cursor position is varied.

3. To vary the selected value, use the UP/DOWN arrow key.

The value is increased or decreased.

Entering a new alphanumerical value

1. Select the parameter.

2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example) or
in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

3. Click on an alphanumeric key to insert a new alphanumerical value.
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Terminating the entry of a numeric value

To terminate the entry of a numeric value:

1. Press the Enter key.

2. Press a unit key combination, e.g. ALT+F10, to assign a unit.

3. Select a "Unit" in the selection field next to the parameter value.

4.5.5 Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited, the
unit is selected either from the list or by means of the front-panel keys. When the entry
is completed, the unit can be changed. In this case the value remains unchanged but is
automatically adapted to the new unit.

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.

Assigning a unit

To assign a unit to a value, use one of the following alternatives:

1. Press a unit key combination, e.g. ALT+F10, on the external keyboard.

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a unit key combination, e.g. ALT+F10, on the external keyboard.

2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

The new unit is indicated in the value field of the menu.

4.5.6 Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.
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To select a item from a list, proceed as follow:

1. Press ENTER key to open the list.

2. Use the UP/DOWN arrow keys on the external keyboard to navigate through the list.

3. To confirm the selection, press the ENTER key.

4.5.7 Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the param-
eter type and the way this parameter is set.

Confirming settings

► To confirm the settings, press the Enter key or select an unit (ALT + F9 or +F10 or
+F11 or +F12).
See also ​chapter 4.5.5, "Working with Units ", on page 91.

Note: Variations by means of arror keys are immediately set.

Confirming multiple values

In some cases, like for instance when configuring the carriers for a multicarrier CW signal
in a carrier table, it is useful first to enter few values and to confirm them together. Such
settings require additional confirmation. Not yet confirmed settings are displayed on a
yellow background as an indication that the currently displayed values do not represent
the target signal.

► To confirm these settings, select the "Accept" button.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

► To confirm a parameter with On/Off state, enable the parameter.

If time-consuming calculations are required, signal generation is automatically switched
off and calculation is interrupted to allow the user to make further settings. Calculation is
restarted with the RECALCULATE key and the modulation is switched on again when
the calculation is completed.
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Preventing recalculation
If an instrument function requires several parameter settings, switch the function off to
prevent a recalculation.
Enable the function after the entire configuration of the settings have been compleated.
The signal is recalculated only once.

4.5.8 Restoring the Previous Value

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.

Restoring values

In the case operation from the keyboard, previous values can be restored as long as the
new value is not confirmed, i.e. the entry is not completed.

► To restore the values, press the ESC key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

A confirmation query is displayed.

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are displayed.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" message
displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calculation
that requires longer calculation time. The termination of such a calculation restores the
previous values.

► Press the ABORT button to terminate the calculation.

All previous values are restored.
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4.6 Editors

The R&S SMATE provides user-friendly editors for defining data lists as well as control
and marker signals. Lists containing frequency and level value pairs are used for the list
mode and the user-defined level correction.

Internally generated data lists can be used for digital modulation and digital standards;
the same applies to internally defined control and marker signals.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to ​chapter 4.8, "File Management", on page 102.

4.6.1 Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

Editing list mode data lists

1. To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the "Frequency/
Hz" column.

If no list has been selected, a blank list of only one row is displayed.

2. Press the LEFT/RIGHT arrow keys to change between the colums.
Use the UP/DOWN arrow keys to mark a row.

3. Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz" and
"Power/dBm" table columns. A blank row is inserted at the end of the list.
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4. To select a row, select the "GoTo" button and press the ENTER key.
Use the numeric keys to enter the row index in the entry field and press the
ENTER key to confirm the entry.

The cursor moves to the selected row.

5. To insert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

6. Use the "Save"/"Save As..." function to save the edited list under its current name or
under a new name.
Enter the file name in the "File Select" dialog and select the directory (see ​chap-
ter 4.8.1, "File Select Dialog", on page 103).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.

Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the "File
Select" menu (see section ​chapter 4.8, "File Management", on page 102) or by changing
an existing list which will then be saved under a new name.

1. To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correction
Data" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

4.6.2 Working with Data Editor

The "Data Editor" is used to internally generate binary data lists for digital modulation and
digital standards.

A list of binary values with a maximum length of 2^31 bits can be entered in the "Data
Editor". This value corresponds to a file size of approx. 268 Mbyte. While it is being pro-
cessed, the file is continuously automatically buffered. When the dialog is exited, the file
is automatically saved with the new values, i.e. there is no extra "Save" button. Depending
on the size of the file, saving may take some time.

Editing an existing data list

1. To access a data editor and open an existing data list for editing, use the arrow keys
to select the associated button "Edit Data List... " in the individual menu.

The selected data list is displayed.
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The cursor marks the start value of the list.
To increase readability, the bits are displayed in groups of four. The current cursor
position, the length of the list and the list file name are displayed above the list. The
offset starts with the value 0 which corresponds to the bit position on the left side of
the first row, i.e. the beginning of the list. On the left edge of the editor, the last three
offset positions are specified at the beginning of the row.

2. Use the numeric keys to enter the values 0 or 1.

3. To delete a value, use the arrow keys to mark the bit that follows the value to be
deleted.
Press the INSERT key to activate the insert mode. Values cannot be deleted in the
overwrite mode.
Press the BACKSPACE key.

The value before the marked bit is deleted.

4. To select a bit position, select the "GoTo" button and press the ENTER key.
Enter the bit position in the "GoTo Offset" entry field by means of the numeric keys
and confirm the entry.

The cursor marks the bit at the selected position.

5. To copy and paste any range of bits at any position in the list:

a) Use the the arrow keys to mark the start bit of the selection.
b) Select the "Start Select" button and use the the arrow keys to mark the selection.
c) Click the "Copy" button.
d) Navigate to the insert possition and select "Paste".

The selected and copied bits are pasted after the selected position.

6. To display and edit the values in hexadecimal form, select the "Hex" button.

Each four bits are displayed as a hexadecimal value: To increase readability, the
hexadecimal values in turn are displayed in pairs of two. The hex functions are auto-
matically assigned to the numeric keys at the front panel.

7. To save the data list, press the ESC key.

The list is saved automatically when the dialog is closed.
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Creating a new data list

1. To create an empty data list, in the individual menu select "List Management > Select
Data List to Edit... > Create Data List" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit Data List..." in the
individual menu.

4.6.3 Working with Control and Marker List Editor

The control and marker signals for digital modulation and digital standards can be very
conveniently graphically defined in a "Control and Marker List Editor". The available
marker signals – and, with custom digital modulation, the CW, Hop, Burst Gate and Lev
Att control signals – can be defined in this editor.

While it is being processed, the file is continuously automatically buffered. Depending on
the size of the file, saving may take some time.

The various functions of the editor are explained in the individual menus. This section
focuses to the general use of the graphic editor.

Example: 
The following figure shows the "Slot Marker Definition Editor" of the "GSM/EDGE" dialog
as an example.

The upper area displays the signal for which the marker signals are to be defined. On the
left side, the available signals (marker and control signals) are listed and colour-coded.

Auxiliary functions are offered in the lower editor area, e.g. presetting for the ramps in
the marker signal, cursor positioning by entering the bit position and possible editing by
means of value entries in a table.

The actual graphic definition of the control signals occurs in the center area of the editor.
Each control signal is represented by means of a colored line along the bit axis. A cursor
can be shifted alongside this line and marks the position where a ramp is to be set. The
color of the cursor changes depending on the current function.
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Use the ENTER key to switch over between the colors (and therefore functions):
● black: marks the bit position on the marker line
● yellow: sets a ramp
● green: activates the marked ramp for shifting.

Accessing control and marker list

1. To access the control list editor (e.g. "CList Dig Mod") and open an existing list for
editing, use the arrow keys to select "Custom Digital Mod > List Management > Edit
Control List".

2. To access the slot marker list editor (e.g. "Slot Marker") and open an existing list for
editing, use the arrow keys to select "GSM/EDGE > Burst Editor > Slot Marker Def-
inition".

Editing an existing control or marker list

1. Activate control/marker signal line for editing.
Use the arrow keys to mark the editable graphic area and press the ENTER key.
Select the control/marker signal line to be edit and press the ENTER key.

The cursor is active for the selected line.

2. Define the cursor position.
Select the parameter "Cursor Position", specify the position by means of the numeric
keys and confirm the entry.

The cursor is positioned according to the entry. If the entered value exceeds the
selected length of the definition range, the length is adjusted automatically.

3. Configure the control and marker signals (see ​"Handling of Ramps" on page 99).

4. Define length of control list ("Custom Dig Mod" only).
Select the "Total List Length" entry field and press the ENTER key. Enter the length
by means of the numeric keys and confirm the entry.

The control list length is defined.
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5. Zoom displayed range ("Custom Dig Mod" only) in long control lists.
To zoom the displayed area around the current "Cursor Position", select the param-
eter "Visible/Bits Visible", enter the number of symbols/bits to be displayed by means
of the numeric keys and confirm the entry.
Select the "Zoom In" button and press the ENTER key.

The selected number of symbols/bits around the current cursor position are dis-
played.
Ramps outside the displayed area are not lost by zooming.

6. Use the "Save"/"Save As..." function to save the edited control/marker list under its
current name or under a new name.
Enter the file name in the "Create File" dialog and select the directory (see ​chap-
ter 4.8.1, "File Select Dialog", on page 103).

Handling of Ramps

1. Set a new ramp
Use the arrow keys or use the parameter "Cursor Position" to move the cursor to the
position where the ramp is to be inserted. Press the ENTER key.

The ramp transition of the newly set ramp depends on the current status (high or low)
of the control signal. If the signal is low, a ramp with low-high transition is generated;
if the signal is high, a ramp with high-low transition is generated.

When ramps are set between existing ramps, the transition of the new ramp is also
defined by the status of the signal before the new ramp. For this reason, a ramp that
has already been set can be assigned low-low or high-high transition (as in the
example), i.e. it will have no effect on the control signal in this configuration. However,
the ramp remains saved, and its position is indicated by a dashed line.

If another change produces effective transition, this ramp will be regenerated.

2. Shift a ramp
An existing ramp can be shifted to any positions. The transitions are adjusted accord-
ingly.
Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.
Press the ENTER key. The cursor again changes colour. The ramp will now be shifted
by means of the cursor. Press the ENTER key. The ramp will be set at the current
position.

Editors



Manual OperationR&S®SMATE200A

100Quick Start Guide 1401.0933.69 ─ 07

The ramp transition depends on the status (high or low) of the control/marker signal
before the ramp.

3. Delete a ramp
Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.
Press the BACKSPACE key.

The ramp will be deleted. The ramp transitions of the other ramps are adapted to the
changed signal status (high or low).

4. Set the ramps in a table
Select the "Edit Table..." button and define the positions and states of the ramps for
the selected marker.
Confirm the entries with "Accept".

5. Preset a marker signal
Select the "Preset" button to preset the marker signal.

The ramps of the selected marker are adjusted according to the selected "Preset
Type".

Creating a new control list

A new control list can be created under a new name either by generating a blank file or
by changing an existing list which will then be saved under a new name.

1. To create an empty control list, select "BB > Cust Dig Mod > List Management... >
Select Control List to Edit > Create Control List" and enter the file name of the new
control list.

2. To open the control list for editing, select the associated button "BB > Cust Dig Mod
> List Management... > Select Control List to Edit > Edit Control List..." and select an
existing control list.

4.7 How to Use the Help System

The R&S SMATE is equipped with a context-sensitive help function. A help page is avail-
able for each parameter and can be called any time during instrument operation.

Compiled online help systems are also available for all functions of the R&S SMATE on
the CD-ROM supplied with the instrument. This help program can be called on any con-
troller with Internet Explorer version V4.0 and higher.

Calling context-sensitive and general help

► To display the general help dialog box, press the HELP (F1) key.
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The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

Contents of the help dialog box

The help dialog box contains two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system provides additionally an "Index" and a "Find" area, as well as "Zoom"
functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents

1. To move through the displayed contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.

The corresponding help topic is displayed.

Navigating in the help topics

1. To scroll through a page, use the UP/DOWN arrow keys.

2. To jump to the linked topic, press the link text.

3. Use the "Previous" or "Next" links to jump to the corresponding topic.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

Using the Index

1. Select the "Go to Index" button.

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
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4. Use the UP/DOWN keys to navigate and select the suitable keyword.

5. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

► Press the HELP (F1) key.

4.8 File Management

The R&S SMATE uses files to save all instrument data, i.e. system and user data.

The user data includes saved instrument settings, data for the different digital standards,
lists for the List mode and the user correction as well as the waveforms for the arbitrary
waveform generator.

The files are stored on the hard disk of the instrument. Drive D:\ can be used to save
user-defined data; any directory structure can be created on D:\. Some default directo-
ries are predefined, but can be changed at any time. The C:\ drive is a protected system
drive. The files on this drive contain data that must not be changed. Therefore, this drive
should not be accessed, since reconstruction of the system partition will lead to data loss.
To prevent inadvertent deletion or overwriting of system files, this drive is not specified
in the file menus. It can be accessed if a protection level (see section "Protection Level"
in the Operating Manual) is revoked.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the E: drive. In the case of a
connected network, all network drives that can be accessed are available. The files are
accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since access
to the files occurs in the individual menus where only the relevant type of file is available.
See ​chapter 4.8.2.1, "Extensions for User Files", on page 106 for an overview of the
supported file extensions.

The user data can be roughly divided into the following data types:
● Settings

Settings, e.g. the frame setting of the GSM/EDGE standard, can be loaded and cur-
rent setting saved to the specified file.

● Lists
Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

● Complex modulation and control data
User data of this type can be loaded. It can be generated either externally or internally.
For internal generation, a new list must be created which will then be edited in the
data and control list editor. These functions are offered in the "Data List Manage-
ment" dialog of the individual modulation menu.
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● Waveforms
Waveforms are generated externally (e.g. by means of the R&S WinIQSIM2 program
that is supplied together with the optional Baseband Generator R&S SMATE-B10)
and can be loaded in the "Arbitrary Waveform Generation" dialog.

The examples whitin this description focus on manual operation from an external monitor
with an external keyboard connected to the instrument.

For more information, refer to:
● ​chapter 4.1, "Legend of Manual Controls", on page 71 for an overview of the keyboard

shortcuts
● to "Instrument Functions" in the Operating Manual for a detailed description of key

functions.

Accessing files with user data

1. To access an editable user data file, select the "Save/Recall" or "File Manger" function
in the individual dialog.

2. To access a loadable data file, select the "Select/New" or "File Manager" function in
the individual dialog.

3. To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.
To access the "File" menu, press the FILE (CTRL+S) key.
For more information, see chapter "Storing and Loading Instrument Data - File Key" in
the Operating Manual.

4.8.1 File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper part,
"Recent Data Sets", the files last used are listed.
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The available drives and directories and the files of the selected directory are displayed.
The currently selected path is displayed above the window. Only the relevant files without
file extensions are displayed. If the area is opened several times, the path last selected
is displayed. When a file is saved or created, its name is user-selectable; the extension
is assigned automatically and cannot be entered. The file is saved to the selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this rea-
son, this directory cannot be chosen from the "File Select" menu.

Example: 
The following example shows the "File Select" menu of the GSM/EDGE digital standard
when "Recall Predefined Frames" is selected.

Working with the File Select dialog

1. Access the "File Select" dialog (see ​"Accessing files with user data" on page 103).

2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save a file.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" button.

5. Create a new file.

File Management
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To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individual
editor.

4.8.2 File Manager

The "File Manager" allows general file management such as copying, shifting, renaming
and deleting files as well as generating new directories.

Thus, also externally created files, for example waveforms created by using the
R&S®WinIQSIM2 program, can be saved to the R&S SMATE by copying them from a
memory stick or a network to the internal hard disk.

Use the "File Type" to select a file type form the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See ​chapter 4.8.2.1, "Exten-
sions for User Files", on page 106 for an overview of the supported file extensions. The
available drives and directories and the files of the selected directory are displayed. The
currently selected path is displayed above the windows. If the area is opened several
times, the path last selected is displayed. Unlike the "File Select" window, the "File Man-
ager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see ​"Accessing files with user
data" on page 103).

2. Navigating in the "File Manager" dialog.
Operation is similar to the operation of menus with several areas.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to which
the file is to be moved and select the "Paste" button. If the target directory already
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contains a file with the same name, a confirmation query is displayed to confirm
overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.

4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the
"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

4.8.2.1 Extensions for User Files

The following table list all available file extensions for user files. The currently available
files on the instrument depends on the installed options.

Table 4-2: List of the automatically assigned file extensions in the instrument

Function/Digital
Standard

List type Contents File suffix

Instrument State Settings Instrument settings *.savrcl

"User Correction" List User-defined level correction values *.uco

"List Mode" List User-defined frequency/level value pairs *.lsw

"Frequency
Response Correc-
tion"

Settings User-defined frequency response correction file *.frc

"Arbitrary Waveform
Generator"

Waveform ARB waveforms

ARB multi segment waveforms

*.wv

 Waveform ARB multi carrier settings *.arb_mult 
carr

 Configuration
data

Configuration file for creation of multisegment
ARB waveforms

*.inf_mswv

 Play List ARB Sequencing List *.wvs

"DM" Data List Digital modulation data *.dm_iqd
*.tdm

 Control List Data to control digital modulation *.dm_iqc

 Settings Digital modulation settings *.dm

 User Standard Digital modulation user standard *.dm_stu

 User Mapping Digital modulation user mapping *.vam

 User Filter Digital modulation user filter *.vaf

"NRP Settings" Settings NRP Settings *.nrp

EX-IQ-Box User Settings EX-IQ-Box User Defined Settings *.iqbox

"Fading" Fading Fading data *.fad

"GSM/EDGE" Settings GSM/EDGE settings *.gsm
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Function/Digital
Standard

List type Contents File suffix

 Slot User-defined slot data *.gsm_slu

 Frame User-defined frame data *.gsm_fu

 Slot Higher symbol rate slot *.gsm_hslu

 Frame Higher symbol rate frame *.gsm_hfu

"Bluetooth" Bluetooth Set-
tings

Complete setting of the Bluetooth menu *.bto

"TETRA" TETRA Set-
tings

Complete setting of the TETRA menu *.tetra

"3GPP FDD" Settings Complete setting of the 3GPP (FDD) menu *.3g

 Settings Channel coding enhanced DPCH channels
(downlink)

*.
3g_ccod_dl_s

 Settings Channel coding enhanced DPDCH channels
(uplink)

*.3g_ccod_ul

"CDMA2000" Settings Complete setting of the CDMA2000 menu *.cdma2k

"TD-SCDMA2000" Settings Complete setting of the TD-SCDMA2000 menu *.tdscdma

 Settings Test Model for TD-SCDMA2000 *.tdtmd

1xEV-DO Settings Complete setting of the 1xEV-DO menu *.evdo

"IEEE 802.11
WLAN"

Settings Complete setting of the IEEE 802.11 WLAN
menu

*.wlan

"IEEE 802.11 n
WLAN"

Settings Complete setting of the IEEE 802.11n WLAN
menu

*.wlann

 Settings Beamforming data *.bmf

"IEEE 802.16
WiMAX"

Settings Complete setting of the IEEE 802.16 WiMAX
menu

*.wimax

"EUTRA/LTE" Settings Complete setting of the EUTRA/LTE menu *.eutra

 Settings TDD Settings *.lte_tdd

 Settings User-defined IQ-File *.iqw

"GPS" Settings Complete setting of the GPS/A-GPS menu *.gps

 Settings GPS Almanac Settings *.txt
*.alm
*.al3

 Settings GPS Waypoints File *.txt

 Settings GPS Generated Almanac File *rs_al
*.rs_yuma

 Settings GPS Ionospheric File *.rs_ion

 Settings GPS Navigation Data *.rs_nav
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Function/Digital
Standard

List type Contents File suffix

 Settings GPS UTC File *.rs_utc
*.rs_acq

"FM-Stereo" Settings Complete setting of the FM-Stereo menu *.fmstereo

 Settings FM-Stereo Group Type Settings *.fm_gt

 Settings FM-Stereo Group Hex Type Settings *.fm_ghex

 Waveform File Waveform File *.wav

"Sirius" Settings Complete setting of the Sirirus menu *.sirius

"XM-Radio" Settings Complete setting of the XM-Radio menu *.xmradio

 Settings XM-Radio TWTA Data *.twta

"DVB" Settings Complete setting of the DVB menu *.dvb

 Settings DVB Transport Stream *.gts
*.ts
*.trp

"DAB/T-DMB" Settings Complete setting of the DAB/T-DMB menu *.dab

 Settings DAB ETI Files *.eti
*.xeti
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5 Remote Control Basics
This chapter provides basic information on operating an instrument via remote control.

5.1 Remote Control Interfaces and Protocols

The instrument supports different interfaces for remote control. The following table gives
an overview.

Table 5-1: Remote control interfaces and protocols

Interface Protocols, VISA*)

address string
Remarks

Local Area
Network
(LAN)

Protocols:
● VXI-11
● socket communica-

tion (Raw Ethernet,
simple telnet)

VISA*) address string:

TCPIP::host
address[::LAN device
name][::INSTR]

A LAN connector is located on the front or rear panel of the
instrument, or both.

The interface is based on TCP/IP and supports various protocols.

For a description of the protocols refer to:
● ​chapter 5.1.3.1, "VXI-11 Protocol", on page 112
● ​chapter 5.1.3.2, "Socket Communication", on page 112

USB VISA*) address string:

USB::<vendor
ID>::<product
ID>::<serial num-
ber>[::INSTR]

USB connectors are located on the front or the rear panel of the
instrument, or both.

For a description of the interface refer to ​chapter 5.1.4, "USB
Interface", on page 113

GPIB (IEC/
IEEE Bus
Interface)

VISA*) address string:

GPIB::primary
address[::INSTR]

(no secondary address)

Optional GPIB bus interfaces according to standard IEC 625.1/
IEEE 488.1 are located on the rear panel of the instrument.

For a description of the interface refer to ​chapter 5.1.5, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 113.

*) VISA is a standardized software interface library providing input and output functions to communicate with
instruments. A VISA installation on the controller is a prerequisite for remote control over LAN (when using
VXI-11 protocol) or USB interface. However, no VISA installation is necessary to remote control while using
socket communication. For more information, see ​chapter 5.1.1, "VISA Libraries", on page 110.

Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE
bus interface.

SCPI (Standard Commands for Programmable Instruments)

SCPI commands - messages - are used for remote control. Commands that are not taken
from the SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI
version 1999. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of device-specific commands, error handling and the status registers.
The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from
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John M. Pieper (R&S order number 0002.3536.00) offers detailed information on con-
cepts and definitions of SCPI.

Tables provide a fast overview of the bit assignment in the status registers. The tables
are supplemented by a comprehensive description of the status registers.

5.1.1 VISA Libraries

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. The I/O channel (LAN or TCP/IP, USB, GPIB,...) is
selected at initialization time by means of the channel–specific address string ("VISA
resource string"), or by an appropriately defined VISA alias (short name). A VISA instal-
lation is a prerequisite for remote control using the following interfaces:

● ​chapter 5.1.3.1, "VXI-11 Protocol", on page 112
● ​chapter 5.1.4, "USB Interface", on page 113
● ​chapter 5.1.5, "GPIB Interface (IEC/IEEE Bus Interface)", on page 113

For more information about VISA refer to the user documentation.

5.1.2 Messages

The messages transferred on the data lines are divided into the following categories:

● Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.

● Instrument messages
Instrument messages are employed in the same way for all interfaces, if not indicated
otherwise in the description. Structure and syntax of the instrument messages are
described in ​chapter 5.3, "SCPI Command Structure", on page 128. A detailed
description of all messages available for the instrument is provided in the chapter
"Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:
– Commands
– Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are sub-
divided according to two criteria:
● According to the effect they have on the instrument:

– Setting commands cause instrument settings such as a reset of the instrument
or setting the frequency.
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– Queries cause data to be provided for remote control, e.g. for identification of the
instrument or polling a parameter value. Queries are formed by directly appending
a question mark to the command header.

● According to their definition in standards:
– Common commands: their function and syntax are precisely defined in standard

IEEE 488.2. They are employed identically on all instruments (if implemented).
They refer to functions such as management of the standardized status registers,
reset and self test.

– Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI compliant" in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement results,
instrument settings and information on the instrument status.

5.1.3 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting of
a connector, a network interface card and protocols. For remote control via a network,
the PC and the instrument must be connected via the LAN interface to a common network
with TCP/IP network protocol. They are connected using a commercial RJ45 cable. The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and (for specified protocols only) the VISA
program library must be installed on the controller.

VISA library

Instrument access via VXI11 protocols is usually achieved from high level programming
platforms using VISA as an intermediate abstraction layer. VISA encapsulates the low
level VXI or GPIB function calls and thus makes the transport interface transparent for
the user. See ​chapter 5.1.1, "VISA Libraries", on page 110 for details.

IP address

Only the IP address or the computer name (LAN device name) is required to set up the
connection. The IP address/computer name is part of the "visa resource string" used by
the programs to identify and control the instrument. The visa resource string has the form:

TCPIP::host address[::LAN device name][::INSTR] , where:

● TCPIP designates the network protocol used
● host address is the IP address
● LAN device name is the computer name of the control device (alternative to IP

address)
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● INSTR indicates that the VXI-11 protocol is used

Example: 
Instrument has the IP address 192.1.2.3; the valid resource string is:
TCPIP::192.1.2.3::INSTR
Computer name is RSSM1; the valid resource string is:
TCPIP::RSSM1::INSTR

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.

5.1.3.1 VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the exchanged
messages is adhered to and interrupted links are identified. With this protocol, messages
cannot be lost.

5.1.3.2 Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred as “Raw Ether-
net communication”, does not necessary require a VISA installation on the remote con-
troller side.

The simplest way to establish socket communication is to use the built-in telnet program.
The telnet program is part of every operating system and supports a communication with
the software on a command-by-command basis. For better utilization and to enable auto-
mation by means of programs, user defined sockets can be programmed.

Socket connections are established on a specially defined port. The socket address is a
combination of the IP address or the host name of the instrument and the number of the
port configured for remote-control. All R&S Signal Generator use port number 5025 for
this purpose. The port is configured for communication on a command-to-command basis
and for remote control from a program.

5.1.3.3 LAN Interface Messages

In the LAN connection, the interface messages are called low–level control messages.
These messages can be used to emulate interface messages of the GPIB bus.
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Command Long term Effect on the instrument

&ABO Abort Aborts processing of the commands just received.

&DCL Device Clear Aborts processing of the commands just received and sets
the command processing software to a defined initial state.
Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control).

&GTR Go to Remote Transition to the "remote" state (remote control).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with that
of a pulse at the external trigger signal input.

&LLO Local Lockout Disables switchover from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to manual opera-
tion by means of the front panel keys

&POL Serial Poll Starts a serial poll.

5.1.4 USB Interface

For remote control via the USB connection, the PC and the instrument must be connected
via the USB type B interface. A USB connection requires the VISA library to be installed.
VISA detects and configures the R&S instrument automatically when the USB connection
is established. You do not have to enter an address string or install a separate driver.

USB address

The used USB address string is:

USB::<vendor ID>::<product ID>::<serial number>[::INSTR]
where:

● <vendor ID> is the vendor ID for Rohde&Schwarz
● <product ID> is the product ID for the R&S instrument
● <serial number> is the individual serial number on the rear of the instrument

Example: 
USB::0x0AAD::0x0046::100001::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz
0x46 is the product ID for the R&S SMATE
100001 is the serial number of the particular instrument

5.1.5 GPIB Interface (IEC/IEEE Bus Interface)

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the program
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libraries for the programming language used must be provided in the controller. The con-
troller must address the instrument with the GPIB bus address (see ​chapter 5.1.5.2,
"GPIB Instrument Address", on page 115).

Characteristics

The GPIB interface is described by the following characteristics:

● Up to 15 instruments can be connected
● The total cable length is restricted to a maximum of 15 m; the cable length between

two instruments should not exceed 2m.
● A wired "OR"-connection is used if several instruments are connected in parallel,

since the slowest instrument determines the speed.

Any connected IEC bus cable must be terminated by an instrument or controller.

5.1.5.1 GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the attention
line (ATN) being active (LOW). They are used for communication between the controller
and the instrument and can only be sent by a computer which has the function of a GPIB
bus controller. GPIB interface messages can be further subdivided into:

● Universal commands: act on all instruments connected to the GPIB bus without
previous addressing

● Addressed commands: only act on instruments previously addressed as listeners

Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all instru-
ments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the command
processing software to a defined initial state. Does not change the instrument
settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig-
ure)

End of the parallel-poll state.

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing
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Addressed Commands

Addressed commands are encoded in the range 00 through 0F hex. They only affect
instruments addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep). The
effect of the command is the same as with that of a pulse at the
external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote" state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the
command processing software to a defined initial state. Does not
change the instrument setting.

5.1.5.2 GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory preset, but it can be changed if it
does not fit in the network environment. For remote control, addresses 0 through 30 are
allowed. The GPIB address is maintained after a reset of the instrument settings.

Changing the GPIB address of the instrument

The GPIB address can be changed manually or using a remote control command.

1. Manually: press the SETUP key and select "Remote > GPIB".

Select parameter "GPIB channel address" and set the GPIB address.

2. Using remote control command:
SYST:COMM:GPIB:ADDR 18

5.2 Starting a Remote Control Session

The instrument and the controller have to be connected with the suitable cable and
switched on.

A remote control program must open a connection to the instrument (using VISA func-
tionality), before it can send commands to and receive device responses from the instru-
ment.
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Instrument Address
In order to operate the instrument via remote control it must be addressed using the
defined interface address. See ​chapter 5.1.3, "LAN Interface", on page 111, ​chap-
ter 5.1.4, "USB Interface", on page 113 or ​chapter 5.1.5, "GPIB Interface (IEC/IEEE Bus
Interface)", on page 113 for details.

The VISA resource strings are indicated in the "Setup > Remote Channel Settings" menu.

Refer to ​chapter 5.2.3, "Examples", on page 117 for practical examples on setting up of
a remote control link and starting of a remote control session.

5.2.1 Switching to Remote Control

When it is switched on, the instrument is always in the manual operating state and can
be operated via the front panel controls (for instruments equipped with a display) or via
mouse and external keyboard.

Starting remote control

1. Send a command from a controller to the instrument.

The instrument is switched to remote control as soon as it receives a command from
the controller.

While remote control is active, operation via the front panel or via mouse and key-
board is disabled and "REMOTE" is displayed in the status line.

The instrument remains in the remote state until it is reset to the manual state via the
instrument or via the remote control interface (see ​chapter 5.2.2, "Returning to Man-
ual Operation", on page 117).

Tip: Switching from manual operation to remote control and vice versa does not affect
the other instrument settings.

2. Although operation via front panel, mouse and keyboard is disabled, the dialog boxes
can still be opened, e.g. to verify settings, but buttons and setting fields are displayed
in gray and cannot be activated.
Use the command SYST:KLOC ON to disable the access to the dialogs.
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3. To prevent unintentional return to manual operation, disable the LOCAL key of the
instrument using the &LLO command (see ​chapter 5.1.3.3, "LAN Interface Mes-
sages", on page 112).

The instrument switches to "REM-LLO" state and transition to manual mode is not
anymore possible via the remote control command *GTL.

Switching to manual mode is only possible via remote control then.

4. Enable the LOCAL key with the interface message &NREN.

5.2.2 Returning to Manual Operation

Before returning to manual control, command processing must be completed. Otherwise,
the instrument switches back to remote control immediately.

► To return to manual operation, use one of the following ways:

a) Press the LOCAL key on the front panel.
b) Select "Setup > Remote Control Channels" and press "Local".
c) While using the socket communication, terminate the remote control session.
d) Send the interface command &GTL via the remote control interface.

Tip: Use the &NREN to enable the LOCAL key if the key is disabled.

5.2.3 Examples

This sections provides examples for setting up of remote control connection and starting
a remote control session over LAN and GPIB interfaces.

This section assumes basic knowledge of programming and operation of the controller.
A description of the interface commands can be obtained from the relevant manuals.

5.2.3.1 Remote Control over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib_32.bas) are added to the projects.
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Drivers for instrument, e.g. IVI-COM and LabVIEW drivers, are available in the download
area of the product website (http://www2.rohde-schwarz.com/en/products/
test_and_measurement/product_categories/signal_generation/).

Starting a remote control session over GPIB

As a prerequisite, the GPIB address of the instrument, which is factory-set to 28, must
not have been changed.

1. Connect instrument and controller using GPIB cable and switch them on.

2. Execute following commands on the controller:

a) Open port to the instrument
CALL IBFIND("DEV1", generator%)

b) Inform controller about instrument address
CALL IBPAD(generator%, 28)

c) Reset instrument
CALL IBWRT(generator%, "*RST;*CLS")

d) Set instrument to new address
CALL IBWRT(generator%, "SYST:COMM:GPIB:ADDR 18")

e) Inform controller about new address
CALL IBPAD(generator%, 18)

The GPIB address of the instrument is changed.

3. To return to manual operation, press the LOCAL key at the front panel.

5.2.3.2 Remote Control over LAN using VXI-11 Protocol

Through the examples in this section, the program 'Measurement & Automation Explorer'
from National Instruments under Windows operating system is used for setting up a LAN
remote control link and starting a remote control session.

Configuring the controller

The instrument is preconfigured for networks using DHCP (dynamic host configuration
protocol). If this configuration is used, enter the computer name in the position of the IP
address.

To enable the external controller to communicate with the software via TCP/IP protocol,
set up a remote control link as follow:

1. Connect the controller and the instrument to the network (network cable) and switch
them on.

2. Start the 'Measurement & Automation Control' program on the controller.

3. Select "Devices and Interfaces > Create New".
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4. Select "VISA TCP/IP Resource" and confirm with "Next".

5. Choose the type of TCP/IP resource you wish to add and select Next.

6. Enter the IP address or the host name of the R&S SMATE and select "Next".
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7. Enter the alias name if required.
The alias name must not be mistaken for the computer name. It is only used for
instrument identification within the program and displayed in the menu as an option
in case of an Ethernet link.

8. Confirm the settings with "Finish".
The instrument is configured and the settings are displayed in the "TCP/IP Set-
tings" tab.

9. To test the connection, select "Validate".
A message indicates whether the link to the instrument can be set up or not.

Starting a Remote Control Session
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If a connection cannot be set up, check whether the controller and the instrument are
connected to the network (network cable) and switched on. Correct spelling of the IP
address or the computer name can also be checked. For further error location, inform
the network administrator. In large networks, specification of additional addresses
may be required for link setup, e.g. gateway and subnet mask, which are known to
the network administrator.

The instrument is now registered in the program and can be addressed via the
resource string or alias name.

Starting a remote control over LAN (using VXI-11)

1. Start the 'Measurement & Automation Explorer' on the controller.

2. In the "Configuration" window, select "Device and Interfaces > VISA TCP/IP Resour-
ces", select the required instrument and select "Open VISA Test Panel".

3. In the "viWrite" tab, write the command to be send to the instrument and select
"Execute".

Starting a Remote Control Session
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Instrument responses are displayed on the "viRead" tab.

Tip: For further program operation refer to the online help of the program.

5.2.3.3 Remote Control over LAN using Socket Communication

This chapter provides an example on how to establish a remote control connection over
telnet protocol and a simple sockets-based program example that can be further devel-
oped.

Setting up a Telnet Connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SMATE, start the telnet program and
enter the socket address.
The socket address is a combination of the IP address or the host name of the R&S
SMATE and the number of the port configured for remote-control via telnet.
Tip: The R&S SMATE uses the port number 5025 for remote connection via Telnet.

The connection to the instrument is set up and remote-control commands can be
sent.

2. Even if the cursor is not visible on the screen, enter blind a remote-control command
and confirm with Enter.
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After the first remote-control command had been send, the instrument is in the
"REMOTE" state, i.e. instrument control from the front panel or via mouse and key-
board is disabled and "REMOTE" is displayed in the status line.

TcpClient program examples

The following program example shows a simple TcpClient class that is intended to explain
on how to get started with programming of sockets.

The example sets up a socket communication to R&S SMATE and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
using namespace std;

//defines structs for socket handling
#ifndef LINUX
  #include "Winsock2.h"
#else
  #include <netinet/in.h>
#endif

typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
  TcpClient();
  ~TcpClient();
  void connectToServer( string &hostname, int port );
  void disconnect( );
  void transmit( string &txString );
  void receive( string &rxString );
  string getCurrentHostName( ) const;
  int getCurrentPort( ) const;
private:
  string currentHostName;
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  int currentPort;
  int currentSocketDescr;
  SockAddrStruct serverAddress;
  HostInfoStruct * currentHostInfo;
  bool clientIsConnected;
  int receiveBufferSize;
};

TcpClient.cpp

#ifdef LINUX
  #include <netdb.h>
  #include <unistd.h>
#endif

#include "TcpClient.h"
TcpClient::TcpClient()
: currentHostName( "" )
, currentPort( 0 )
, currentSocketDescr( 0 )
, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )
, receiveBufferSize( 1024 )
{}
TcpClient::~TcpClient()
{
  currentHostInfo = NULL;
}
void TcpClient::connectToServer( string &hostname, int port )
{
  currentHostInfo = gethostbyname( hostname.c_str( ) );
  if( currentHostInfo == NULL )
  {
    #ifndef LINUX
      int error = WSAGetLastError();
      switch (error)
      {
        case WSANOTINITIALISED: throw string(" A successful case WSAStartup 
call must occur before using this function."); break;
        case WSAENETDOWN: throw string
(" The network subsystem has failed."); break;
        case WSAHOST_NOT_FOUND: throw string
(" Authoritative answer host not found."); break;
        case WSATRY_AGAIN: throw string
(" Nonauthoritative host not found, or server failure."); break;
        case WSANO_RECOVERY: throw string
(" A nonrecoverable error occurred."); break;
        case WSANO_DATA: throw string
(" Valid name, no data record of requested type."); break;
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        case WSAEINPROGRESS: throw string(" A blocking Windows Sockets 1.1 call 
is in progress, or the service provider is still processing a callback function.")
; break;
        case WSAEFAULT: throw string
(" The name parameter is not a valid part of the user address space."); break;
        case WSAEINTR: throw string
(" A blocking Windows Socket 1.1 call was canceled through case 
WSACancelBlockingCall."); break;
      }
    #endif
 
    currentHostName = "";
    currentPort = 0;
    currentHostInfo = NULL;
    clientIsConnected = false;
    throw string("error connecting host\n" );
  }
  else
  {
    currentHostName = hostname;
    currentPort = port;
    currentSocketDescr = socket(AF_INET, SOCK_STREAM, 0);
    if( currentSocketDescr == 0 )
    {
      currentHostName = "";
      currentPort = 0;
      currentHostInfo = NULL;
      clientIsConnected = false;
      throw string("can't create socket\n" );
    }
    serverAddress.sin_family = currentHostInfo->h_addrtype;
    serverAddress.sin_port = htons( currentPort );
    memcpy( (char *) &serverAddress.sin_addr.s_addr, currentHostInfo->
h_addr_list[0], currentHostInfo->h_length );
    if( connect( currentSocketDescr, ( struct sockaddr *) &serverAddress, 
sizeof(serverAddress ) ) < 0 )
    {
      throw string("can't connect server\n" );
    }
    clientIsConnected = true;
  }
}
void TcpClient::disconnect( )
{
  if( clientIsConnected )
  {
    #ifndef LINUX
      closesocket( currentSocketDescr );
    #else
      close( currentSocketDescr );
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    #endif
  }
  currentSocketDescr = 0;
  currentHostName = "";
  currentPort = 0;
  currentHostInfo = NULL;
  clientIsConnected = false;
}
void TcpClient::transmit( string &txString )
{
  if( !clientIsConnected )
  {
    throw string("connection must be established before any data can be sent\n");
  }
  char * transmitBuffer = new char[txString.length() +1];
  memcpy( transmitBuffer, txString.c_str(), txString.length() );
  transmitBuffer[txString.length()] = '\n'; //newline is needed!
  if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
  {
    throw string("can't transmit data\n");
  }
  delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
  if( !clientIsConnected )
  {
   throw string("connection must be established before any data can be received\n");
  }
  char * receiveBuffer = new char[receiveBufferSize];
  memset( receiveBuffer, 0, receiveBufferSize );
  bool receiving = true;
  while( receiving )
  {
    int receivedByteCount = recv( currentSocketDescr, receiveBuffer,
      receiveBufferSize, 0 );
    if( receivedByteCount < 0 )
    {
      throw string("error while receiving data\n");
    }
    rxString += string( receiveBuffer );
    receiving = ( receivedByteCount == receiveBufferSize );
  }
  delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const
{
  return currentHostName;
}
int TcpClient::getCurrentPort( ) const
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{
  return currentPort;
}

TelnetClient.cpp

//TelnetClient.cpp: Defines the entry point for the console application.//

#include <iostream>
#include "TcpClient.h"
void printUsage()
{
  cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
  int errorCode = 0; //no error
  bool useSingleCommand = false;
  string singleCommand = "";
  string hostname = "";
  int port = 5025;
  string input = "";
  TcpClient client;
  switch( argc )
  {
  case 3:
    useSingleCommand = true;
    singleCommand = argv[2];
  case 2:
    hostname = argv[1];
    break;
  default:
    printUsage();
    getchar();
    return(-1);
  }
  try
  {
#ifndef LINUX
    WORD wVersionRequested = MAKEWORD( 2, 2 );
    WSADATA wsaData;
    int err = WSAStartup( wVersionRequested, &wsaData );
    if ( err != 0 ) 
    {
      throw string ("Could not find a usable WinSock DLL.");
    }
#endif
    client.connectToServer( hostname, port );
    bool terminate = false;
    while( !terminate )
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    {
      char buffer[1024];
      if( useSingleCommand )
      {
        input = singleCommand; //send string
      }
      else
      {
        cout <<">";
        cin.getline( buffer, 1024 );
        input = buffer;
        if( input == "end" )
        {
          terminate = true;
        }
      }
      if( !terminate)
      {
        client.transmit( input ); //send string
        int qPos = input.find( "?", 0 );
        //receive string only when needed
        if( qPos > 0 )
        {
          string rcStr = "";
          client.receive( rcStr );
          cout << rcStr;
        }
      }
      if( useSingleCommand )
      {
        terminate = true;
      }
    }
  }catch( const string errorString )
  {
    cout<<errorString<<endl<<endl;
    cout<<"Press Enter to exit"<<endl;
    getchar();
  }
  client.disconnect( );
  return errorCode;
}

5.3 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
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to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics (key-
words). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.

5.3.1 Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an asterisk
(*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.

5.3.2 Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.
For demonstration purposes only, assume the existence of the following commands for
this section:
● DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
● FORMat:READings:DATA <type>[,<length>]
● HCOPy:DEVice:COLor <Boolean>
● HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
● HCOPy[:IMMediate]
● HCOPy:ITEM:ALL
● HCOPy:ITEM:LABel <string>
● HCOPy:PAGE:DIMensions:QUADrant[<N>]
● HCOPy:PAGE:ORIentation LANDscape | PORTrait
● HCOPy:PAGE:SCALe <numeric value>
● MMEMory:COPY <file_source>,<file_destination>
● SENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
● SENSe:FREQuency:STOP <numeric value>
● SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
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Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper
case letters, the long form corresponds to the complete word. Either the short form or the
long form can be entered; other abbreviations are not permitted.

Example: 
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the man-
ual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or
sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

Example: 
Definition: HCOPy:PAGE:DIMensions:QUADrant[<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selection
used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix 1 is
the default state and used when no specific suffix is specified.
Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The instru-
ment must recognize the long command to comply with the SCPI standard. Some com-
mands are considerably shortened by these optional mnemonics.

Example: 
Definition: HCOPy[:IMMediate]
Command: HCOP:IMM is equivalent to HCOP
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Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.
Example:
Definition:DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow param-
eter with the suffix for the required window.
DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space". If several parameters
are specified in a command, they are separated by a comma (,). For a description of the
parameter types, refer to ​chapter 5.3.3, "SCPI Parameters", on page 132.

Example: 
Definition:HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
Command:HCOP:DEV:CMAP:COL:RGB 3,32,44
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The effect
of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy:PAGE:ORIentation LANDscape | PORTrait
Command HCOP:PAGE:ORI LAND specifies landscape orientation

Command HCOP:PAGE:ORI PORT specifies portrait orientation

Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics needs
to be included in the header of the command. The effect of the command is independent of which of the
mnemonics is used.

Example:

DefinitionSENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
The two following commands with identical meaning can be created:

SENS:BAND:RES 1
SENS:BWID:RES 1

[ ] Mnemonics in square brackets are optional and may be inserted into the header or omitted.

Example: HCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

{ } Parameters in curly brackets are optional and can be inserted once or several times, or omitted.

Example: SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
The following are valid commands:

SENS:LIST:FREQ 10
SENS:LIST:FREQ 10,20
SENS:LIST:FREQ 10,20,30,40

5.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The param-
eters must be separated from the header by a "white space" (ASCII code 0 to 9, 11 to 32
decimal, e.g. blank). Allowed parameters are:

● Numeric values
● Special numeric values
● Boolean parameters
● Text
● Character strings
● Block data

The parameters required for each command and the allowed range of values are speci-
fied in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The mantissa
may comprise up to 255 characters, the exponent must lie inside the value range -32000
to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent alone is not
allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes
are G (giga), MA (mega), MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro)
and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

● G (giga)
● MA (mega), MOHM, MHZ
● K (kilo)
● M (milli)
● U (micro)
● N (nano)

If the unit is missing, the basic unit is used.

Example: 
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example: 
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query,
the numeric value is provided.

● MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

● DEF
DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

● UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width can
be specified via an allocated step command for each parameter which can be set via
UP, DOWN.

● INF/NINF
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INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

● NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instrument
response. This value is not defined. Possible causes are the division of zero by zero,
the subtraction of infinite from infinite and the representation of missing values.

Example: 
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values
The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered following
the quotation mark.
Example: SENSe:LIST:FREQ? MAXimum
Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represented
by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a
query.

Example: 
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the header
by a white space. In the case of a query, the short form of the text is provided.

Example: 
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").
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Example: 
HCOP:ITEM:LABel "Test1" or HCOP:ITEM:LABel 'Test1'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example: 
FORMat:READings:DATA  #45168xxxxxxxx
The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 following
digits indicate the length to be 5168 bytes. The data bytes follow. During the transmission
of these data bytes all end or other control signs are ignored until all bytes are transmitted.
#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL^END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

5.3.4 Overview of Syntax Elements

The following table provides an overview of the syntax elements:

: The colon separates the mnemonics of a command. In a command line the separating semicolon
marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

' '

"

Quotation marks introduce a string and terminate it (both single and double quotation marks are
possible).

# The hash symbol introduces binary, octal, hexadecimal and block data.
● Binary: #B10110
● Octal: #O7612
● Hexa: #HF3A7
● Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

5.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the
following:
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● a <New Line>
● a <New Line> with EOI
● an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the next
command belongs to a different command system, the semicolon is followed by a colon.

Example: 
MMEM:COPY "Test1","MeasurementXY";:HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels in
common, the command line can be abbreviated. To this end, the second command after
the semicolon starts with the level that lies below the common levels. The colon following
the semicolon must be omitted in this case.

Example: 
HCOP:ITEM ALL;:HCOP:IMM
This command line contains two commands. Both commands are part of the HCOP com-
mand system, i.e. they have one level in common.
When abbreviating the command line, the second command begins with the level below
HCOP. The colon after the semicolon is omitted. The abbreviated form of the command
line reads as follows:
HCOP:ITEM ALL;IMM

A new command line always begins with the complete path.

Example: 
HCOP:ITEM ALL
HCOP:IMM

5.3.6 Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard IEEE
488.2.

● The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?, Response: LAND

● Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe:FREQuency:STOP? MAX, Response: 3.5E9

● Numeric values are output without a unit. Physical quantities are referred to the basic
units or to the units set using the Unit command. The response 3.5E9 in the pre-
vious example stands for 3.5 GHz.
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● Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

● Text (character data) is returned in a short form.
Example:
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

5.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

● A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented as
sequential commands. Sequential commands are not implemented in the instrument,
however the execution time of most commands is so short that they act as sequential
commands when sent in different command lines.

● An overlapping command is one which does not automatically finish executing before
the next command starts executing. Usually, overlapping commands take longer to
process and allow the program to do other tasks while being executed. If overlapping
commands do have to be executed in a defined order, e.g. in order to avoid wrong
measurement results, they must be serviced sequentially. This is called synchroni-
zation between the controller and the instrument.

Setting commands within one command line, even though they may be implemented as
sequential commands, are not necessarily serviced in the order in which they have been
received. In order to make sure that commands are actually carried out in a certain order,
each command must be sent in a separate command line.

Example: Commands and queries in one message
The response to a query combined in a program message with commands that affect the
queried value is not predictable.
The following commands always return the specified result:
:FREQ:STAR 1GHZ;SPAN 100 :FREQ:STAR?
Result:
1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:
:FREQ:STAR 1GHz;STAR?;SPAN 1000000
The result could be the value of STARt before the command was sent since the instru-
ment might defer executing the individual commands until a program message terminator
is received. The result could also be 1 GHz if the instrument executes commands as they
are received.
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As a general rule, send commands and queries in different program messages.

Example: Overlapping command with *OPC
The instrument implements INITiate[:IMMediate] as an overlapped command.
Assuming that INITiate[:IMMediate] takes longer to execute than *OPC, sending
the following command sequence results in initiating a sweep and, after some time, set-
ting the OPC bit in the ESR:
INIT; *OPC.
Sending the following commands still initiates a sweep:
INIT; *OPC; *CLS
However, since the operation is still pending when the instrument executes *CLS, forcing
it into the "Operation Complete Command Idle" State (OCIS), *OPC is effectively skipped.
The OPC bit is not set until the instrument executes another *OPC command.

Example: Overlapped command followed by non-conflicting commands
Suppose that the instrument is switched on to provide a real time test signal that requires
some calculation time. At the same time some settings for the configuration of a different
signal are made which do not interact with the generated signal (e.g. the signal may be
used later on). The signal generation and the signal configuration are independent from
each other, so none of the following overlapped commands needs to be synchronized:
SOUR:BB:3GPP:STAT ON
SOUR:BB:GSM:FORM FSK2

Example: Overlapped command followed by conflicting commands
Suppose that the generator is switched on to provide a real time test signal that requires
some calculation time. This signal is to be added to a waveform from the second base-
band generator. In this case the application program must ensure that the real signal is
actually available in the added signal before further action is started. This involves an
appropriate synchronization technique for the first command (the following sseqzuence
assumes an appropriate routing):
SOUR:BB:3GPP:STAT ON
The instrument waits until command has finished.
SOUR2:BB:GSM:STAT ON
Depending on the selected synchronization techniques, non-conflicting commands can
be executed while waiting until the synchronized overlapped command has finished.

5.4.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC?
or *WAI can be used. All three commands cause a certain action only to be carried out
after the hardware has been set. By suitable programming, the controller can be forced
to wait for the corresponding action to occur.
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Table 5-2: Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action Programming the controller

*OPC Sets the Operation Complete bit in the ESR
after all previous commands have been execu-
ted.

● Setting bit 0 in the ESE
● Setting bit 5 in the SRE
● Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is returned.
This is only the case after the Operation Com-
plete bit has been set in the ESR. This bit indi-
cates that the previous setting has been com-
pleted.

Sending *OPC? directly after the command
whose processing should be terminated before
other commands can be executed.

*WAI Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated before
other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped command
is a good choice if the overlapped command takes only little time to process. The two
synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use one
of the following methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.

3. Send the overlapped command with *OPC

4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

Command Sequence and Synchronization
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*OPC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the "-410, Query interrupted"
entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for controlling
the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other
instruments.

5.5 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. Both can be queried with the commands STATus....

5.5.1 Hierarchy of status registers

As shown in the following figure, the status information is of hierarchical structure.
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Fig. 5-1: Graphical overview of the status registers hierarchy

● STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request
Enable (SRE) form the highest level of the status reporting system. The STB provides
a rough overview of the instrument status, collecting the information of the lower-level
registers.

● ESR, SCPI registers
The STB receives its information from the following registers:
– The Event Status Register (ESR) with the associated mask register standard

Event Status Enable (ESE).

– The STATus:OPERation and STATus:QUEStionable registers which are
defined by SCPI and contain detailed information on the instrument.

● IST, PPE
The IST flag ("Individual STatus"), like the SRQ, combines the entire instrument status
in a single bit. The PPE fulfills the same function for the IST flag as the SRE for the
service request.

● Output buffer
The output buffer contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

Status Reporting System



Remote Control BasicsR&S®SMATE200A

142Quick Start Guide 1401.0933.69 ─ 07

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

5.5.2 Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has
different functions. The individual bits are independent of each other, i.e. each hardware
status is assigned a bit number which is valid for all five parts. Bit 15 (the most significant
bit) is set to zero for all parts. Thus the contents of the register parts can be processed
by the controller as positive integers.

Fig. 5-2: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

● CONDition
The CONDition part is written into directly by the hardware or the sum bit of the next
lower register. Its contents reflect the current instrument status. This register part can
only be read, but not written into or cleared. Its contents are not affected by reading.

● PTRansition
The two transition register parts define which state transition of the CONDition part
(none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether the
EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.

– PTR bit =0: the EVENt bit is not set.
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This part can be written into and read as required. Its contents are not affected by
reading.

● NTRansition
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether the
EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.

– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it is
the "memory" of the condition part. It only indicates events passed on by the transition
filters. It is permanently updated by the instrument. This part can only be read by the
user. Reading the register clears it. This part is often equated with the entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result is
then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can
lead to a service request throughout all levels of the hierarchy.

5.5.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described in more detail.

5.5.3.1 Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview
of the instrument status by collecting the pieces of information of the lower registers. A
special feature is that bit 6 acts as the sum bit of the remaining bits of the status byte.

The STB is read using the command ​*STB ​ or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set
in the SRE and the associated bit in the STB changes from 0 to 1, a service request
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(SRQ) is generated. The SRE can be set using the command ​*SRE ​ and read using the
command *SRE?.

Table 5-3: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and speci-
fied in greater detail by polling the error queue. The poll provides an informative error message.
This procedure is to be recommended since it considerably reduces the problems involved with
remote control.

3 Not used.

4 MAV bit (message available)

The bit is set if a message is available in the output buffer which can be read. This bit can be used
to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set and
enabled in the event status enable register. Setting of this bit indicates a serious error which can
be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits of
this registers is set together with its mask bit in the service request enable register SRE.

7 Not used.

5.5.3.2 IST Flag and Parallel Poll Enable Register (PPE)

As with the SRQ, the IST flag combines the entire status information in a single bit. It can
be read by means of a parallel poll (see ​chapter 5.5.5.3, "Parallel Poll", on page 146) or
using the command ​*IST ​.
The parallel poll enable register (PPE) determines which bits of the STB contribute to the
IST flag. The bits of the STB are "ANDed" with the corresponding bits of the PPE, with
bit 6 being used as well in contrast to the SRE. The IST flag results from the "ORing" of
all results. The PPE can be set using commands ​*PRE ​ and read using command *PRE?.

5.5.4 Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. The event status register can be read out using com-
mand ​*ESR ​ on page 150. The ESE is the associated enable part. It can be set using the
command ​*ESE ​ on page 150 and read using the command *ESE?.
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Table 5-4: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument instead.
The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device dependent error occurs. An error message with a number between 300
and 399 or a positive error number, which denotes the error in greater detail, is entered into the
error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between 200 and 300, which denotes the error in greater
detail, is entered into the error queue.

5 Command Error

This bit is set if a command which is undefined or syntactically incorrect is received. An error
message with a number between 100 and 200, which denotes the error in greater detail, is entered
into the error queue.

6 User Request

This bit is set on pressing the LOCAL key, i.e. when the instrument is switched over to manual
operation.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

5.5.5 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods are
used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller in order to find

out who sent a SRQ and why
● Parallel poll of all devices
● Query of a specific instrument status by means of commands
● Query of the error queue
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5.5.5.1 Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which the
control program can react appropriately. An SRQ is always initiated if one or several of
bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these bits com-
bines the information of the error queue or the output buffer. In order to use the possi-
bilities of the service request effectively, all bits should be set to "1" in the enable registers
SRE and ESE.

Example: 
Use command *OPC to generate an SRQ .

*ESE 1 - set bit 0 of ESE (Operation Complete)

*SRE 32 - set bit 5 of SRE (ESB).

After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in the
case of malfunction. The program should react appropriately to the service request.

5.5.5.2 Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard possi-
bility for different instruments to poll the status byte. The method also works for instru-
ments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

5.5.5.3 Parallel Poll

In a parallel poll, up to eight instruments are simultaneously requested by the controller
using a single command to transmit 1 bit of information each on the data lines, i.e., to set
the data line allocated to each instrument to a logical "0" or "1".

In addition to the SRE register, which determines the conditions under which an SRQ is
generated, there is a Parallel Poll Enable register (PPE) which is ANDed with the STB
bit by bit, considering bit 6 as well. This register is ANDed with the STB bit by bit, con-
sidering bit 6 as well. The results are ORed, the result is possibly inverted and then sent
as a response to the parallel poll of the controller. The result can also be queried without
parallel poll using the command ​*IST ​.
The instrument first has to be set for the parallel poll using the command PPC. This com-
mand allocates a data line to the instrument and determines whether the response is to
be inverted. The parallel poll itself is executed using PPE.
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The parallel poll method is mainly used to find out quickly which one of the instruments
connected to the controller has sent a service request. To this effect, SRE and PPE must
be set to the same value.

5.5.5.4 Query of an instrument status

Each part of any status register can be read using queries. There are two types of com-
mands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level reg-
isters.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

5.5.5.5 Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the
error queue are detailed plain text error messages that can be looked up in the Error Log
or queried via remote control using SYSTem:ERRor[:NEXT]? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor[:NEXT]? provides one entry from
the error queue. If no error messages are stored there any more, the instrument responds
with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially
in the test phase of a controller program the error queue should be queried regularly since
faulty commands from the controller to the instrument are recorded there as well.

5.5.6 Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except *RST and
SYSTem:PRESet, influence the functional instrument settings. In particular, DCL does
not change the instrument settings.
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Table 5-5: Resetting the status reporting system

Event Switching on supply
voltage

Power-On-Status-
Clear

DCL, SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear STB, ESR - yes - - - yes

Clear SRE, ESE - yes - - - -

Clear PPE - yes - - - -

Clear error queue yes yes - - - yes

Clear output buffer yes yes yes 1) 1) 1)

Clear command processing and
input buffer

yes yes yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINATOR>
clears the output buffer.

5.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast,
the priority of remote control is the "predictability" of the instrument status. Thus, when a
command attempts to define incompatible settings, the command is ignored and the
instrument status remains unchanged, i.e. other settings are not automatically adapted.
Therefore, control programs should always define an initial instrument status (e.g. using
the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own.
Each controller program should instruct the instrument to initiate a service request in case
of malfunction. The program should react appropriately to the service request.

Error queues

The error queue should be queried after every service request in the controller program
as the entries describe the cause of an error more precisely than the status registers.
Especially in the test phase of a controller program the error queue should be queried
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regularly since faulty commands from the controller to the instrument are recorded there
as well.

5.7 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These com-
mands have the same effect and are employed in the same way on different devices.
The headers of these commands consist of "*" followed by three letters. Many common
commands are related to the Status Reporting System.

Available common commands:

*CAL ​.............................................................................................................................149
*CLS ​.............................................................................................................................149
*ESE ​.............................................................................................................................150
*ESR ​............................................................................................................................150
*IDN ​.............................................................................................................................150
*IST​..............................................................................................................................150
*OPC ​............................................................................................................................150
*OPT​............................................................................................................................151
*PCB ​............................................................................................................................151
*PRE ​............................................................................................................................151
*PSC ​............................................................................................................................151
*RCL ​.............................................................................................................................152
*RST ​.............................................................................................................................152
*SAV ​.............................................................................................................................152
*SRE ​............................................................................................................................152
*STB​.............................................................................................................................152
*TRG​............................................................................................................................153
*TST​.............................................................................................................................153
*WAI​.............................................................................................................................153

*CAL

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status.
Responses > 0 indicate errors.

*CLS

CLear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the
QUEStionable and the OPERation registers to zero. The command does not alter the
mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only
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*ESE <Value>

Event Status Enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets
the register to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

IDeNtification: returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-

sion>"

Example: Rohde&Schwarz,ZVA8-4Port,12345,0.10.1.23
Usage: Query only

*IST?

Individual STatus query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit which
is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed.
This bit can be used to initiate a service request. The query form writes a "1" into the
output buffer as soon as all preceding commands have been executed. This is used for
command synchronization.
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*OPT?

OPTion identification query

Queries the options included in the instrument. For a list of all available options and their
description refer to the CD-ROM.

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned for
options that are not installed.

Usage: Query only

*PCB <Address>

Pass Control Back

Indicates the controller address to which remote control is returned after termination of
the triggered action.

Setting parameters: 
<Address> Range: 0  to  30

Usage: Setting only

*PRE <Value>

Parallel poll Register Enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on Status Clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.
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*RCL <Number>

ReCaLl calls up the instrument settings from an intermediate memory identified by the
specified number. The instrument settings can be stored to this memory using the com-
mand ​*SAV ​ with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

*RST

ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

*SAV <Number>

SAVe stores the current instrument settings under the specified number in an intermedi-
ate memory. The settings can be recalled using the command ​*RCL ​ with the associated
number.

To transfer the stored instrument settings in a file, use the com-
mand :MMEM:STOR:STAT.

*SRE <Contents>

Service Request Enable

Sets the service request enable register to the indicated value. This command determines
under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.

Usage: Query only
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*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal (Manual Trigger). This common command complements the commands of
the TRIGger subsystem.

Usage: Event

*TST?

self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service
Manual supplied with the instrument). "0" indicates no errors occured.

Usage: Query only

*WAI

WAIt to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and ​
*OPC ​).
Usage: Event

Common Commands
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A Hardware Interfaces
This section covers hardware related topics, like pin assignment of the GPIB bus inter-
face, monitor and AUX I/O connectors.

The remote control interfaces are described in detailes in the Operating Manual, section
"Remote Control Basics".

All other interfaces are described in ​chapter 2.1, "Front Panel Tour", on page 13 and ​
chapter 2.2, "Rear Panel Tour", on page 15.

For specifications refer to the data sheet.

A.1 GPIB Bus Interface

Pin assignment

Fig. 1-1: Pin assignment of GPIB bus interface

Bus lines

● Data bus with 8 lines D0 to D7:
The transmission is bit-parallel and byte-serial in the ASCII/ISO code. D0 is the least
significant bit, D7 the most significant bit.

● Control bus with five lines:
IFC (Interface Clear): active LOW resets the interfaces of the instruments connected
to the default setting.
ATN (Attention): active LOW signals the transmission of interface messages, inactive
HIGH signals the transmission of device messages.
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SRQ (Service Request): active LOW enables the connected device to send a service
request to the controller.
REN (Remote Enable): active LOW permits switchover to remote control.
EOI (End or Identify): has two functions in connection with ATN:
– ATN=HIGH active LOW marks the end of data transmission.
– ATN=LOW active LOW triggers a parallel poll.

● Handshake bus with three lines:
DAV (Data Valid): active LOW signals a valid data byte on the data bus.
NRFD (Not Ready For Data): active LOW signals that one of the connected devices
is not ready for data transfer.
NDAC (Not Data Accepted): active LOW signals that the instrument connected is
accepting the data on the data bus.

Interface Functions

Instruments which can be controlled via GPIB bus can be equipped with different interface
functions. The interface function for the R&S SMATE are listed in the following table.

Table 1-1: GPIB bus interface functions

Control character Interface function

SH1 Handshake source function (source handshake), full capability

AH1 Handshake sink function (acceptor handshake), full capability

L4 Listener function, full capability, de-addressed by MTA.

T6 Talker function, full capability, ability to respond to serial poll, deaddressed
by MLA

SR1 Service request function (Service Request), full capability

PP1 Parallel poll function, full capability

RL1 Remote/Local switch over function, full capability

DC1 Reset function (Device Clear), full capability

DT1 Trigger function (Device Trigger), full capability

A.2 AUX I/O Connector

For an overview of the signals that can be applied at the USER connector, see section
"User Marker / AUX I/O Settings" (table "USER Connector Signals") in the Operating
Manual.
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Table 1-2: Pin assignment of the AUX I/O Connector connector

Pin Signal Description

1 .. 25 Ground ⊥ Ground

26 LEV ATT Signal input/output for controlling the level attenuation.

For two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.

With external envelope curve control ("Custom Digital Modulation" only), the
pin is the input for the control signal LEV_ATT.

With internal envelope curve control, the control signal LEV_ATT is output
for Path A.

27 CW MODE Signal input for controlling the switchover between the modulated and
unmodulated RF signal with activated external modulation/CW switching in
the "Custom Digital Modulation" menu.

For two-path instruments, the CW control signal affects Path A and/or Path
B.

Signal output for the CW control signal with internal source selected. This
signal marks the CW mode in which digital modulation is deactivated and the
RF signal is output in unmodulated form. In the case of digital standards with
selectable modulation mode, the signal indicates the active modulation mode
(GSM: (G)MSK = high, 8PSK EDGE = low).

28 INST TRIG B Input for external triggering of the analog modulations, sweeps and List mode.
HOP input for controlling the frequency hopping mode with external source
in List mode (Path B).

The instrument trigger input for Path A is input via the DIGITAL I/O interface.

29 .. 38 PARDATA0 ..
PARDATA9

Parallel data input/output 0...D with 10-bit word width for digital modulation.

If the data source "External Parallel" is selected, these pins are the data
inputs.

If a different data source is selected, the data is output here ("Custom Digital
Modulation", Path A).

39 USER 3 USER input/output which can be configured for various purposes.
The following signals can be applied to the pin:
● Marker 4 (output path A or path B)
● CW Mode Out (output path A or path B)
● No Signal (Blank) Marker (output Path A or B). This signal marks the

blank time in the List mode.
● HOP (output path A or B). This signal marks the trigger for frequency

hopping in the List mode.
● Trigger (output path A or path B)

This signal marks the trigger event caused by the selected trigger signal
(internally or externally) of path A or B.
Additional signals for path B are available in the case of two-path instru-
ments. The corresponding signals for Path A are applied at the pins of
the AUX I/O or DIGITAL I/O interface (Clock Out).

● Clock Out (output Path B; bit or symbol clock pulse)
This signal corresponds to the clock signal for digital modulations.

● LEV ATT (input/output path B)
● BURST (input/output path B)

40 USER 4 USER input/output which can be configured for various purposes.

41 MARKER 3 Output for the freely programmable marker signal 3 of Path A. The output is
permanently assigned.

42 MARKER 2 B Output for the freely programmable marker signal 2 of Path B.

AUX I/O Connector
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Pin Signal Description

43 MARKER 3 B Output for the freely programmable marker signal 3 of Path B. The output is
permanently assigned.

44 not used not used

45 BURST Signal input/output for controlling the burst ramp.

For two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.

With external envelope curve control ("Custom Digital Modulation" only), the
pin is the input for the control signal "BURST_RAMP".

With internal envelope curve control, the control signal "BURST_RAMP" is
output for Path A.

46 EXT TUNE Tuning input for the internal reference frequency.

47 BITCLK Output Bit clock for internal mode.

For two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.

48 USER 2 USER input/output which can be configured for various purposes.

49 SYMBCLK Symbol clock output for internal mode.

With two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.

50 not used not used

A.3 Monitor Connector (MONITOR)

The 15-pin Sub-D female connector MONITOR at the rear panel is intended for connect-
ing an external VGA monitor.

Table 1-3: Pin assignment of the MONITOR connector

Monitor Connector Pin Signal Pin Signal Pin Signal

1 Red (output) 6 GND 11 (NC)

2 Green (output) 7 GND 12 (NC)

3 Blue (output) 8 GND 13 HSYNC (output)

4 (NC) 9 GND 14 VSYNC (output)

5 GND 10 GND 15 (NC)

A.4 Digital I/O interface

Input/output for serial data of digital signals as well as settable trigger and control signals
of the baseband.

 

 

Monitor Connector (MONITOR)
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Table 1-4: Pin assignment of the Digital I/O connector

Pin Signal Description

1... 25 Ground Ground

26 TRIGGER 1 Input for triggering digital modulations, digital standards
and ARB (paths A and/or B).

27 TRIGGER 2 Input for triggering digital modulations and standards and
ARB (paths A and/or B).

28 MARKER 1 Output for the freely programmable marker signal 1 of
path A for triggering and control of external devices.

29 MARKER 2 Output for the freely programmable marker signal 2 of
path A for triggering and control of external devices.

30 MARKER 1 B Output for the freely programmable marker signal 1 of
path B for triggering and control of external devices.

31 USER 1 Input/output for configurable signals for triggering and
control.
The following signals can be applied to the connector:
● Marker 3/4 (path A or B)
● Clock Out (path B, bit or symbol)
● CW mode Out (path A/B)
● No signal (blank) marker (path A/B)
● HOP (path A/B)

More USER input/outputs are available on the AUX I/O
interface.

32 INST TRIG A Input for external triggering of the analog modulations,
sweeps and List mode. HOP input for controlling the fre-
quency hopping mode with external source in List mode
(path A).

The instrument trigger for path B is input via the connec-
tor AUX I/O.

33 CLK OUT Output for internal (bit or symbol) clock signal (path A,
the internal clock signal of path B can be output at one
of the USER interfaces).

This output is also provided via the connector AUX I/O to
enable the use of a single connector for the input of par-
allel data.

34 DATA Serial data input/output for digital modulation of path A.
If the data source "external serial" is selected, these pin
is the data input. If an internal data source is selected,
the data is output here ("Custom Digital Modulation",
path A).

35..38 not used Pins are not used.

39 OPC A Output for Operation Complete signal of path A. Active
High signals that all remote control commands have
been executed. The output is always active.

Digital I/O interface
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Pin Signal Description

40 RF OFF A Input for fast switching of the RF output A (see section
"Level - EMF Menu" in theOperating Manual).

The input must be activated in the "Level/EMF" dialog or
via remote control command. Active High (1) switches
the RF output off. A subsequent Active Low (0) switches
the RF output on again. The RF Output must be switched
on when the input is activated, otherwise the control sig-
nal has no effect on the status of the RF Output. Switch-
ing is performed very fast (10us). However, the attenua-
tion of the switched off output is considerably less than
after regular switch-off, because the connection between
the RF output and attenuator is not interrupted

41 MOD OFF A Input for fast switching of I/Q modulator of path A (see
section "Level - EMF Menu" in theOperating Manual).

The input must be activated in the "Level/EMF" dialog or
via remote control command. Active High (1) switches
the modulations off. A subsequent Active Low (0)
switches the modulations on again. The modulations
must be switched on when the input is activated, other-
wise the control signal has no effect on the status of the
modulations. Switching is performed very fast (10s).
The control signal has no effect on the status of the digital
modulations in the baseband block or of the analog mod-
ulation of the RF block. An exception is broadband ampli-
tude modulation which uses the I/Q modulator.

42 OPC B Output for Operation Complete signal of path B. This sig-
nal indicates that all remote control commands have
been executed. The line is always active.

43 RF OFF B Input for fast switching off the RF output B (see pin 40).

44 MOD OFF B Input for fast switching off I/Q modulation and broadband
amplitude modulation of path B (see pin 41).

45 FHOP_DATA Data input for Fast Hop list mode (see section "List Mode"
in the Operating Manual)

46 FHOP_CLK Clock input for Fast Hop list mode (see section "List
Mode" in the Operating Manual)

47 FHOP_STRB Strobe input for Fast Hop list mode (see section "List
Mode" in the Operating Manual)

48..50 not used Pins are not used.

Digital I/O interface
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